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About This Guide

This guide addresses questions frequently asked by design team members when using Oracle
Primavera Submittal Exchange to upload, retrieve, track changes, and archive construction
project documents. Architects, Consultants, Engineers, and Owners should use this guide.






About Consent Notices

Consent notices alert you to the need to protect personal information (PI). You and your
organization might be collecting, processing, storing, and transmitting Pl while using Submittal
Exchange. When you accept a consent notice, your consent covers the collection, processing,
storing and transmission of PI data in all areas of Submittal Exchange and means of retrieving
data from Submittal Exchange, including but not limited to project export, downloaded tables,
reports, documents, web services, API, archival reports, project reports, event history, admin
logs, project team page, all access logs, user list, and my account page.

You may be asked to provide consent to show that you understand the need to treat Pl as
secure data. You may also be asked to provide consent for your organization to collect, process,
store, and transmit your PI. If you refuse consent, you will be denied access to Submittal
Exchange.

In This Section

Viewing your Pl Data in Submittal EXchange............cccovvviiiiiii e, 11

Viewing your Pl Data in Submittal Exchange

You can see your Pl in Submittal Exchange from the My Account and Team Member pages.
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Submittal Exchange for Outlook

In This Section

Downloading and Installing Submittal Exchange for OutlooK .................cevvvvviieeennnee. 13
Working with the Submittal Exchange for Outlook ..., 13
Uploading Files to My LiBIrary .........ccoooe i 16
Uploading FileS t0 @ LOQ.......coieeiiiiiie e e e e e e e 16

Downloading and Installing Submittal Exchange for Outlook

To download and install the Submittal Exchange for Outlook:

1) From the top banner, select the Help icon.
2) Select the Contact Us tab.
3) Select the Download button under the Submittal Exchange for Outlook section.

4) Choose Save File when prompted to open the Submittal Exchange for Outlook.exe file, and
select the location where to want to save the .exe file.

5) The installation wizard will walk you through the installation. Follow the instructions to install
the plugin. You will be prompted to accept the terms and conditions.

After the installation process is complete, you will see the Primavera Submittal Exchange
menu appear on the top banner of your Outlook.

Logging in to Submittal Exchange
1) Open Outlook, and select the Primavera Submittal Exchange menu on the top banner.
2) Alog in page appears, enter your Submittal Exchange credentials.

After you have successfully logged in, you can use the Submittal Exchange for Outlook to
upload emails and attachments.

Working with the Submittal Exchange for Outlook

The Submittal Exchange for Outlook allows you to easily upload email attachments from Outlook
into Submittal Exchange. Using this plugin you can upload files without first downloading the
attachments onto your computer and then uploading them in Submittal Exchange.

You can upload files to individual logs (log types 1-8)) or My Library.

From the top banner on Outlook, select Primavera Submittal Exchange to view the menu
options.

» Upload to Log: Select this option to upload documents to a specific log (log types 1-8).
» Upload to My Library: Select this option to upload files to My Library.
» Help: Select to view if there are updates available for this plugin.

13
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» Logout: To logout of your Submittal Exchange session.

[ oy e a e . = ga . | = 0 cann—
— File Home  Send / Receive  Folder  View S0 EVERRelnliie]] Exchange

—.. [ - Y 'dah' ™
e [l . HE I /1 L
F HE B \:J LY J
——— 1. A )
Linlaoad Unload T Haln WaYalsll}s
Upload Upload lo Logout
T 1 RA .1l
o Log My Library
TP S-p——, T ] g I mmimn F1 mmemn s &
Actions Otner | Login/Logotit



Submittal Exchange for Outlook

Right Pane
Use the right pane to upload files into My Library or to a log.
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Uploading Files to My Library

To upload files sent to you via email to your Submittal Exchange library:

1)
2)

3)
4)
5)
6)

From Outlook, select the email which has the files you want to upload.

Select Primavera Submittal Exchange from the top banner, or expand the Submittal
Exchange pane displayed on the far right corner of your email.

Select Upload To My Library.

From the Upload to My Library pop-up window, select the files you want to upload.
Select Browse, to include additional files from your computer.

Select Upload.

Tip:

To remove files, uncheck the checkbox or select Remove next to a file.

Uploading Files to a Log

To upload files sent to you via email to a log using the Submittal Exchange plugin:

1)
2)

3)
4)

5)

6)

7)

8)
9)

From Outlook, select the email which has the files you want to upload.

Select Primavera Submittal Exchange from the top banner, or expand the Submittal
Exchange pane displayed on the far right corner of your email.

Select Upload To Log.

From the Upload window, select the Project, Log, Section or Category, and Open Items
where you want to add this file.

Select the upload options. Choose from: Upload Email with attachments or Upload Files
ONLY.

If you selected the option Upload Files ONLY:

a. Select individual checkboxes to choose the files you want to upload.

b. Select Browse if you want to include additional files from your computer.
Select Upload.

The Add Submittal page opens up within Submittal Exchange.

Review the information and make changes if necessary.

The Description field by default is name of the file you imported. To add another
description, select Multiple to the right of the description. Enter an additional item
description in the Other field.

10) Select Save.
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Your submittal uploads and an email notification is sent.

Notes:

= You are able to set a priority, if the item is of high importance or low.
The best practice is to enter a reason for the priority in the Remarks
field.

= The Remarks field is for high-level administrative comments. The



Submittal Exchange for Outlook

comments are included in both the body of the email sent out and in
the Remarks column in Display Full
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What is Submittal Exchange for Design?

Submittal Exchange for Design is a comprehensive collaboration tool for improving efficiency
and communication during the design phase of a project.

Some of the things that Submittal Exchange for Design provides are:

» Comprehensive design document sharing (drawings, specs, models, etc.)

» Collaborative whiteboard and automatic synchronization of large files

» Automatic notifications and detailed upload and download histories

» Seamless transition into construction phase features when design is completed

Note: To schedule a demo please go to
www.oracle.com/applications/primavera/products/submittal-exchangef/in
dex.html and select Submittal Exchange for Design. From there you
can select Schedule Demo to complete the form to receive a
personalized presentation of Submittal Exchange for Design.
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How Can | Get Submittal Exchange Pricing?

Pricing information for Submittal Exchange is usually provided to Architects, General
Contractors, and Owners.

1) Please contact our Sales Team by phone at 1-800-714-0024 ext. 1 or by email at
subex-sales_ ww@oracle.com.

2) The sales representative will provide a copy of Submittal Exchange's pricing structure.
Note: Due to a large number of inquiries, we would like to state that

Subcontractors are NOT charged for use of the Submittal Exchange
system.

User Registration

To register users in Submittal Exchange:

1) From the Registration page, first enter your personal information.
2) Select Continue.

3) Next enter your company information.

4) Select Continue.

5) Accept the terms and conditions.

6) Select Continue. The Registration Complete page displays after you have finished the
registration process.

Tips:
» The required fields have a red asterisk.

» Select the Add button next to Office drop-down to add a new location. Select Edit to edit the
location.

» You can edit some field values that are auto-populated.

Adding a New Project to Submittal Exchange

General Contractors, Architects, or Owners can request a new project setup on Submittal
Exchange. Your Client Relationship Consultant (CRC) or a representative from our sales team
can assist you. Contact the sales team at 1-800-714-0024 x1.

The following information is required for project setup:

Official project name
Architect's contact information, including email
General Contractor's contact information, including email

4
4
4
» Project manual or submittal schedule of the project.
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Upon completion of an order form, we will begin to set up your project.

How to Upload or Change Your Company's Logo on the Submittal Exchange

Website

When logged into Submittal Exchange:

Select Company Account under your name in the upper right hand corner of your screen to see
your Company Info.

1) Under the Organization label, select Manage Logo to the right of your company name. A
dialog box appears.

2) Select the Browse button to search for the appropriate file on your computer.
» Choose a GIF or JPEG file.
» Select Open. The file name displays in the dialog box.

3) Select Upload.

4) Preview the new logo and select Save to use it.

5) You may need to select Refresh to see the new logo after saving it.

Note: Only .gif and .jpeg files are allowed for upload as a logo.

The company logo appears on the Project Index page and within the project. Only users within
your company see this logo.

Submittal Exchange User Name

A user name is a user's full email address. For example, user name =
sampleuser@samplecompany.com.

How to Reset a Password

Note: The username is always the user's full email address. This is
universal to every user on the system.

1) Go to www.oracle.com/applications/primavera/products/submittal-exchange.html.
2) Select Login. Sign In screen appears.

3) Select Forgot Password.

4) Enter your full email address and select Continue.

5) You will receive an email from Submittal Exchange that contains a link to reset your
password.

Note: Do not copy and paste this password into the password text box
the next time you login. Make sure to type it completely to ensure it
works properly.

OR If you are logged into the system, you can change your password.
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1)
2)
3)
4)

5)

Select My Account under your name in the upper right hand corner of your screen, to see
your Account Info.

Select the Change Password button. The screen changes.
Enter your old password in the Old Password field.

Enter your new password in the New Password and Re-Type Password fields. The
password is encrypted, so only black dots appear as you type.

Select the Save button.

Note: Your password must be between 8 and 20 characters and have at
least one uppercase character, one lowercase character, one number,
and one special character (e.g. |@#3$%"&*)

Creating New Roles

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1)
2)
3)
4)

5)
6)

Select Manage Roles button.
A dialog box appears. In the upper right corner, select Add New Role.
Enter the name of the role in the Role Name field.

Under Access Role, choose the distinction that best matches the new role from the
drop-down list.

Under Security Privileges, select all the actions this new role has the ability to perform.
Select Save.

Notes:

= The new role user does not appear in the Project Team tab until you
have assigned an user to this role.

= You must be a Project Leader to copy roles on your project.

= Administrators and Project Leaders can edit custom role labels at the
log and project level.

Editing Roles

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1)
2)
3)

4)
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Select the Manage Roles button.
From the Manage Project Roles page, select a role to edit it. The Edit Role page displays.

From the Edit Role page, you can change the Role Name, Access Role or Security
Privileges.

Select Save.

Note: Administrators and Project Leaders can edit custom role labels at
the log and project level.
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Copying Existing Roles from One Project to Another

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Atthe top of the page, select Manage Roles.
2) A dialog box appears. In the upper right corner, select Add New Role.

3) To add arole used in one of your other projects, choose Select a Project and select the
project name that contains the role from the drop-down list.

4) Next select Role, and choose the role from the drop-down list.
» Select Load.

5) Ensure all settings for the role appear correct.

6) Select Save.

Note: Only Project Leaders may copy roles on a project.

Adding Team Members to a Project as a Project Leader

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select +Add User button. A new Add Team Member dialog box appears.
2) Select Project Role from a drop-down list.

3) Enter the new team member's email address.

4) Select Next. A new dialog box appears.

5) The company name is auto populated based on the email address domain. If the email
address domain is associated with multiple companies, choose a company from the
drop-down list. If the email address domain is not associated with a company, use the New
Company to add a company.

6) For a new company, enter the company or organization name in the Company Name field.
7) (Optional) Add a Title and Phone Number.

8) To add logs, choose Select from list and select logs.

9) To add sections, choose Select from list and select sections.

10) To add categories, choose Select from list and select categories.

Note: Select only those sections and categories the user must review
and receive notifications for. Users have the ability to view all sections or
categories on a project.

11) From the Frequency of Email Notifications drop-down menu, select how frequently you
want the user to receive email notifications. The default option is User Default.

12) Select applicable email notifications.
13) Select Save.
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Notes:

= A Project Leader can add anyone to the project.

= An event is added to the Event History table when you enable or
disable users.

Adding Team Members to a Project by an Architect

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select Add User. A new Add Team Member dialog box appears.

2) Select the new team member's company. Select a company listed on the project, or select
New Company.

3) Enter the new team member's email address.

4) Select Next. A new dialog box appeatrs.

5) For a new company, enter the company or organization name in the Company Name field.
6) Select a Project Role from a drop-down list.

7) To add logs, choose Select from list and select logs.

8) To add sections, choose Select from list and select sections.

9) To add categories, chose Select from list and select categories.

10) Select applicable email notifications.

11) Select Save.

Note: Architects can add users from their own office as well Consultants.

Adding Team Members to a Project by a Consultant

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select Add User. A new Add Team Member dialog box appears.
2) Enter the new team member's email address.
3) Select Next. A new dialog box appears.
» Your user settings automatically populate the new team member's settings.
4) Select Save.

Note: Consultants are able to add users from their own office.

Adding Team Members to a Project by an Owner

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select Add User. A new Add Team Member dialog box appears.
2) Enter the new team member's email address.
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3) Select Next. A new dialog box appears.
» Your user settings automatically populate the new team member's settings.
4) Add a Title.
5) To add sections, choose Select from list and select sections.
6) To add categories, choose Select from list and select categories.
7) Select applicable email notifications.
8) Select Save.

Notes:
= Owners can add other users from their own office with the same
domain.

= When a new Owner user is added to a project, the user settings are
automatically populated. If settings for the new user need to be
different, contact the Project Leader to make changes.

Disabling a User Account

Use the Manage Users page to disable a user's access to their account. An email is sent to the
user indicating that their account has been disabled. The user whose account has been disabled
has the option to cancel the request within 7 business days. The option to cancel the disable
request is displayed when the users tries to log in.

To disable a user account:

1) From the drop-down menu under your user name, select Company Account. The
Company Info page is displayed.

2) Select the Manage Users button.

3) From the Manage Users page, select the X icon on the Disable column next to the user you
want to disable. Note: If a disable request has been submitted for a user then the X icon will
not be displayed.

4) Enter the reason you want to disable to account.

5) Select Disable.

Exporting Company User List

From the Manage Users page you can export a list of all users in the company. The exported
file lists all company users along with their login ID, the office location, and lists if they are an
active user on a project.

To export the company user list:

1) From the drop-down menu under your username, select Company Account. The Company
Info page is displayed.

2) Select the Manage users button.
The Manage Users page displays.

3) Select the Export link to download and save the Excel file.
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How Does the Clone Setting Feature Work?

The Clone Settings feature is available within the Project Team tab when adding a new team
member. It will copy a selected user's role, log access, sections, categories, and email
notifications. This reduces the manual entry of these items.

Note: Only the users you can edit are available for Clone Settings.

Cloning a User's Settings

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select Add User. A new Add Team Member dialog box appears.

2) Select the new team member's company. Select a company listed on the project, or select
New Company.

3) Enter the new team member's email address.
4) Select Next. A new dialog box appeatrs.
5) Select the user to clone from the Project Team Members drop-down list.

6) Select Clone Settings. This will copy the selected project team member's user role, log
access, sections, categories, and email notifications.

7) Verify the cloned settings are correct and edit as needed.
8) Select Save.

Note: Only the users you can edit are available for Clone Settings.

How to Fix a User Assigned to an Incorrect Company

If you have added a user and their company association came up incorrectly:

1) Leave the user on the Project Team.

2) Send an email to subex-help_ww@oracle.com or call Technical Support at 1-800-714-0024
ext.2.

3) Be sure to include:
» The email address of the user you need to correct
» The project name
» The company the user should be assigned to (Company Name, Address, Phone).

Adding Review Codes for Reviewers' Companies

Select Company Account under your name in the upper right hand corner of your screen, to
see your Company Info.

1) Under the Organization section, select Edit review codes to the right of your company
name. A dialog box appears.
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2) Enter a new code and explanation.

Note: To create a new line item for Resubmittal, select the Resubmittal
Req'd check box next to a review or action code.

3) In the dialog box, select Save changes.
4) On Company Info, select Save changes.

How to Download an Item Without a Submittal Exchange Account

A Submittal Exchange user can send an item via email to someone without a Submittal
Exchange account. The email includes a Click to Download link.
Note: File downloads are only active for 7 days.

1) Select the link within the email notification. The link leads to the Submittal Exchange Terms
of Use page.

2) Review the Terms of Use.

3) Select the | have read and understood the Terms of Use check box.

4) Select the | agree to the Terms of Use check box.

5) Enter your full name.

6) Enter your company name.

7) Enter your email.
Note: Only the email recipient can download the item.

8) Select Continue.
The PDF file download starts.

Note: A Submittal Exchange user can send the email directly from a log or through the Return
to Subcontractor dialog. See Sending a Submittal via Email (on page 75) for step-by-step
instructions.
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Navigating Submittal Exchange Menus and Tabs

The top of each Submittal Exchange page has tabs and links for navigating the system.

Note: Not all users will see all menus, tabs, or options. Access to some
features depends on which role or team you are on.

1) Help Menu - Use the options under the Help icon to learn about Submittal Exchange and
reach out for help.

2) Account Menu - Use the options under your name to review account information.

3) Project Index - Use the Project Index to select a project.

4) Message Center - Use the Message Center to see emails you receive from the system.
5) Reports Menu - Use the options under the Reports menu to generate reports or API keys.
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6) Project Logs Tab - Use the Project Logs to select a log.

7) Project Team Tab - Use the Project Team tab to view and manage team members who
have access to the project on the system.

8) Sections & Categories Tab - Use the Sections & Categories tab to edit the expected
items for submittals and closeouts.

9) Preferences - Use the Preferences to view and edit project preferences.
10) Event History - Use the Event History to review previous events on your project.
11) Alert Icon - (not shown) - Use the Alert icon to access alerts on the system.

12) Log Progress - Use the Log Progress to see the percentage of items that have been
submitted and reviewed.

13) Savings Calculators - Use the Savings Calculators to see what your organization has
saved by using the system.

Help Menu

When logged into Submittal Exchange, the Help menu is located at the very top of your page.
Use the options under the Help icon to learn about Submittal Exchange and reach out for help.

» Guides & Videos- Provides access to the user guides for the Construction and Design
Teams. You can also view Step-by-step videos that show how to use the Primavera
Submittal Exchange system. You can also access a link to the Submittal Exchange
Essentials on the Constructions Engineering Hub.

» Contact Us-

» Contact information to email or call customer support. It also includes the link to the
Primavera Submittal Exchange Community.

» Environment Status: Select the link to view information on schedule maintenance and the
status of Submittal Exchange. For more information, see topic Environment Status (on
page 30).

» Upload Project Manual: Select to upload specification manuals to Oracle Submittal
Exchange setup team. For more information, see topic Uploading Project Specification
Manual (on page 51).

» Submittal Exchange for Outlook: See topic Submittal Exchange for Outlook (on page
13).

Environment Status

The Oracle Cloud Status Page provides information on scheduled maintenance and the status
of Submittal Exchange. You can view events and updates directly on the status page or by
subscribing to email alerts.

You can access the Oracle Cloud Status Page here:
https://statuspage.gbucnss.oci.oraclecloud.com/status/cegbu_subex/
(https://statuspage.gbucnss.oci.oraclecloud.com/status/cegbu_subex/)
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How can | subscribe to get updates?
To subscribe to the Status Page to receive email updates.

1) On the Status page, select Subscribe to updates.

2) On the Subscribe page, enter your email address, and select Subscribe to updates.

3) You will receive an email to confirm your subscription. From the email, select Confirm
Subscription to complete the subscription.

To manage or cancel your subscription, select Subscribe to updates and enter your email, or
select Manage Your Subscription from a Status Page email alert. On the Oracle Cloud Global
Status Page Notifications page, make changes to your data center selections or select Cancel
Subscription.

What does an event's status indicate?

Scheduled Maintenance: This section displays the maintenance events along with the
scheduled date, time, and duration. Any outage or performance impact is communicated to
customers ahead of time.

Events: An event will typically move through the following statuses:

» Event Under Investigation: The issue and its impact are described.

» Event Identified: The issue has been identified. If available, the estimated resolution
time is also communicated.

» Event Resolved: The event has been resolved and the site is fully operational.

After each unplanned event is resolved, our teams will conduct an investigation to determine the
cause, assign corrective actions, and ensure efforts are made to prevent the issue from
happening in the future.

Account Menu

When logged into Submittal Exchange, your name appears at the top of the page. This is
Account menu; Use the options under it to review account information.

» My Account-Review or update user account information, preferences, or email settings

» Company Account-See or update organization information, manage users, review codes,
or manage logos
» My Library-Store and access documents in a personal library

Where is My Library?

The My Library feature is available to store documents in a personal library on Submittal
Exchange. When logged into Submittal Exchange, select your name in the top right hand corner
of the page, and choose Manage My Library. This feature is available at all times.

To view your files or add files to My Library select the Manage My Library. A My Library dialog
box appears with a table of files.

View a non-PDF file in My Library

To view non-PDF files:
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On the right hand side of the table in the My Library dialog is an Action column. Actions allow
you to Delete, Rename, and View your files.

Tip:
» You can zoom, and rotate your documents.

Edit a PDF File in My Library

1) On the right hand side of the table in the My Library dialog is an Action column. Actions
allow you to Delete, Rename, and Edit your files.

2) Select the Edit function. A built-in PDF editor appears. Make your changes.
3) Save and return to My Library.

Note: A My Library icon will be to the right of all Browse options when
uploading documents into Submittal Exchange.

Tips:
» You can zoom, rotate, and download your documents.

» You can set view preference from the Account Info page (Select your name and choose My
Account.).

Merging Login IDs

You can use the Merge Login ID option from the My Account page to copy your projects,
sections, categories, phases and email notifications from an old or incorrect user ID to a new ID.
When the merge is successful all projects and corresponding roles, email settings, logs, sections
and categories access are moved from the account you merged to your logged in account.

Important!
You cannot undo the merge, and the merged account cannot be
recovered. Perform the actions on this page with care.

To merge login IDs:

1) From the My Account page, select the Merge Login ID button.
The Merge Accounts page is displayed. The left pane displays details about your account.

2) From the right pane, enter the login credentials of the account you want to merge.
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Notes:

= You will be required to complete the registration if the account is valid,
but the registration has not been completed.

= You cannot undo the action of merging login IDs. The account you
are merging will be disabled and cannot be recovered.

= The account to be merged should be a valid SE account. If you forgot
the password, you must reset the password before proceeding.

3) Select the Preview & Merge button to preview the account.

4) Select the Confirm Merge and Close button. The Merge Account Confirmation page is
displayed. Logged in account details on the left panel shows the newly added projects.The
account you merged is disabled and removed from all assigned projects. An email
notification will also be sent to your email address.

Project Index

When logged into Submittal Exchange, the Project Index is located at the top of your page. The
Project Index shows a list of the Submittal Exchange projects to which you are assigned. These
projects are organized by project number and project name. Other fields include:

» Contractual End Date-The project end date. The date is displayed in red for projects that
have expired.

» Pending GC/CM-The number of items pending General Contractor or Construction Manager
review

Pending Design Team-The number of items pending Design Team review
Updated (7 days)-The number of items approved in the last 7 days
Total Items-The total number of items in the project.

Note: The Project Index is the page that appears first when you log into
Submittal Exchange.

Working with the Project Index Page

You can associate a color for each project on the Project Index page to easily identify and
categorize projects. In addition, you can sort projects, and change the order of projects
displayed.

» To sort columns, click on a column header.

» To change the order, select and hold the “* reorder icon and move the entire row to a new
location in the table.

» To associate a color, select the 9 paint brush icon and select a color from the Mark with
color dialog box. To remove the color highlighting, select the No Fill option from the Mark
with color dialog box.

» Use the Search box at the top of the page to search by project name or project number.
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» Selecting the number under the pending GC/CM or Design Team column opens the Open
Items tab.

» Select the Export Log link to export the Project Index page to Excel.

Working with Open Items Tab

To view open items in your project, select the Open Items tab from the Project Index page. The
left pane displays all the projects you have access to and the right pane displays the open items
within the project.

Select the Show Open Items Count button to view a count of all open items for the logged in
user. Project specific count is displayed in each project row.

» Use the Filter box to search for a specific project.

» Use filters to select if you want to view your open items or view items that are pending
GC/CM or design reviews.
» Use the My Open Items filter and take action directly from the Open Items tab.

Message Center

When logged into Submittal Exchange, the Message Center is located at the top right corner of
your page.

From the Message Center, you can view all automated emails from Submittal Exchange, these
are emails you receive from notifications@submittalexchange.com. This page is divided into
three panes: top pane, right pane, and left pane.

Top Pane
The top pane contains the Actions menu, and various filter options.

Page Elements Description

Actions drop-down menu You can take the following actions:

Mark All As Read
Mark As Read
Mark As Unread
Flag As To Do

Export selected messages: messages
are downloaded as .zip if there are
multiple selections or as .eml if only
one message is selected.

v v v v Vv

Project You can choose to view all projects or
select a project.

Email Type You can view all email types, or filter
based on a particular type of email, for
example: Discussion or Consultant
Review.
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Filter By Choose from the following options:

» Flagged

» Has Attachment Link
» Unread Emails

» Read Emails

Filter By Date Select a From and To date.

Left Pane

View emails based on the selected filter criteria. Message that have files that you can download
are indicated with a paper clip icon. Use the checkbox to select individual emails, or select the
Select all Messages in this page option. You can use the flag icon to flag individual messages
or select a message and choose Actions > Flag As To Do.

Use the page numbers to navigate between pages or select the Show All option.
Right Pane

The right pane displays the content of the email you selected. You can also download a single
email as a .eml file.

Reports Menu

When logged into Submittal Exchange, the Reports menu is located at the very top right corner
of your page. Use the options under the Reports menu to generate reports or API keys.

» Reports-Generate and review various project and Submittal Exchange reports

» APIs-Get API keys and add API keys.

Note: If you need Submittal Exchange application programming
interface keys (API keys), please contact help@submittalexchange.com
or call technical support at 1-800-714-0024, extension 2.

Project Logs

After selecting a project in Submittal Exchange, tabs appear under the header. The Project
Logs tab lists the logs available on a project. Use the Project Logs drop-down to select a log
for review. The list can include:

» ASIs

» Closeouts

» Daily Reports

» Invoicing and Payment
» PRs

» Photos
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» Project Documents
» RFIs
» RFPs
» Submittals
Project Team

After selecting a project in Submittal Exchange, tabs appear under the header. The Project
Team tab shows teams and team members who have access to the project on Submittal
Exchange.

The following screen elements are displayed on the Project Teams page:

Project Logs v Project Team Sections & Categories Preferences Event History

Project Team Project Name: 43350 - Adam C Powell State Office Building - Rehabilitate Facade | Number: 43350 * @ @ g

| ‘Q i} "role "= Quick Search ‘ m Clear Search I
939 Team Memberse o L e Q e

+Add User % Manage Roles Manage Users v Q Detail View [ Manage Columns v Filter By Companies
. Email Login N
O Company Name Email Sections Categor... Notificatio... Logs As

£} 4 [ Architect or OGS Final Reviewer
O NYS OGS Design & Construction John Schimitsch John.Schimitsch@ogs.ny.gov.tests 013000--22 Bid Docum Items Upload. CAD Coordination, Closeout, Contr. -
4[] Consultant or OGS Design Reviewer
O Superstructures Linda Ho LHo@superstructures.com.tests 000000--99... Bid Docum... Items Upload. CAD Coordination, Closeout, Contr. -
O Superstructures N Kermani nkermani@superstructures.com.tests  000000--99 Bid Docum Items Upload. CAD Coordination, Closeout, Contr. -l

4[] Contractor

O Lo Sardo General Contractors, ... Steven Fenslau sfenslau@losardo.net.tests 000000--99. Bid Docum Items Upload... CAD Coordination, Closeout, Contr ')|
O Lo Sardo General Contractors, Jason Merlo jmerlo@losardo.net.tests 000000--99 Bid Docum. Items Upload. CAD Coordination, Closeout, Contr. -
O Lo Sardo General Contractors, ... Thomas Ragusa tragusa@Iosardo.net.tests 013000--22... Bid Docum... Items Upload. CAD Coordination, Closeout, Contr d

1) Search bar and Quick Search: Use the search bar or the quick search to find a specific
user or company.

2) + Add User button: Select to add a new user. The Add Team Member page is displayed.
3) Manage Roles button: Select to manage project roles. The Manage Project Roles page is
displayed.
4) Manage Users drop-down button: From this drop-down menu, the following options are
displayed:
» Edit Selected Users
» Remove Selected Users
» Bulk User Import
» Copy User From Another PRoject
» Resend Password
» Email Selected Users

5) Detail View or Summary View button: Select to view the grid in a detailed or summary view.
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6) Manage Columns: Select to specify the columns you want displayed in the grid. The
choices selected on the Manage Column now persist across browsers and different Logins.

7) Filter By Companies: Select to narrow the grid by filtering on specific companies.
8) Main Grid: This grid organized into eight columns:

» Company - Lists all companies involved.

» Name - Lists the names of individuals involved.

» Note: If the Name column indicates User must login to confirm name, the person has
yet to log into Submittal Exchange.

» Email - Lists the email addresses of team members. A red indicator is displayed for
undelivered email addresses in the project team.

» Title - Lists titles of the team members.
» Phone - Lists the phone number of team members.

» Sections - Lists the sections that are viewable when to team members upon first log in.
Users can upload, review, and receive email notification receipts for the sections listed.

» Categories - Lists the categories that are viewable when team members first log in.
Users can upload, review, and receive email notification receipts for the categories listed.

» Phases- Lists the phases that are viewable when team members first log in. This column
displays only if it has been enabled during project setup.

» Email Notifications - Controls the emails team members receive based on the Sections
and Categories they have listed.

» Logs Column - Lists the logs that are viewable by the user.

From the Gear menu, you can perform tasks against a role or user. The options
include: Edit Selected Role Users, Remove Selected Role Users, Resend Password,
Email Selected Role User, Edit, Remove, and Send Email.

Sections & Categories

After selecting a project in Submittal Exchange, tabs appear under the header. The Sections &
Categories tab contains the specification sections, expected items (from the project manual or
submittal registry), and any categories that have been created. This information dictates what is
displayed in the Submittal and Closeout logs.

Within this area, a Project Leader can add, edit, or delete specification sections, expected items
and categories.

Users who are not Project Leaders, but do have General Contractor/Construction Manager,
Architect, or Consultant roles can edit the expected items (Submittals and Closeouts).

Preferences

After selecting a project in Submittal Exchange, tabs appear under the header. The Preferences
tab contains project preferences.

Preferences-This controls the name, number, location information, and the functionality
available on Submittal Exchange for the project. Submittal numbering scheme, review flow, and
log settings are all determined through the Preferences tab.
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Internal Project Number-This allows each company to use their own internal project number.
This number is specific to your company on this project.

Required Item Turnaround-This allows each company to adjust the number of days before
they receive reminders about items pending their review.

Contractual Project End Date: This is a view-only field. SE administrators can edit the field.

Approximate Project Size: This is a view-only field. Displays the approximate data size of your
project.

Date Project End Email Sent: This is a view-only field. SE administrators can edit the field.

Use Phases: The ability to add phases is enabled by your administrator. Select the checkbox to
view or add phases to a project. General Contractors and Architects with Project Leader role
access can view, add, and edit phases, but cannot delete existing phases. Select the Edit
Phases button and choose the + Add More Rows link and enter an abbreviation and
explanation for the new phase.

Subcontractor not required for the project: Select this option to disable a subcontractor's
access to a project.

PDF Flattening: If your administrator has set the option to flatten PDFs, all uploaded PDF files
will be automatically flattened.

Note: Contact your Submittal Exchange administrator to add a Supplier
or Manufacturer label to your projects

Event History

After selecting a project in Submittal Exchange, tabs appear under the header. The Event
History tab shows a list of events that were recorded for your project. You can filter this table to
view events generated by date, user, or type.

Screen Elements Description

Events drop-down menu Select the event you want to filter by and
select the Add to Search button. The
default option is All Events.

Users drop-down menu Select the users you want to filter by, the
default option is All Users. The list of users
displayed is not restricted to project users,
it shows all users that have at least one
event in the project.

Filter by Date Select to filter by date. The options
include: Today, This Week, This Month, or
Custom Date.
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Search box Enter a keyword to search across the
event history table.
Use to display or hide the in-column filter
Column Filter button row.

Select to print the table.
Print button

_ Clears all selected filters. To remove
Clear Filter button individual filters, select the x next to the
filter.

Tip:

Events which require action to be taken via Email have the text Via Actionable Email next to
the event.

Alert Icon

After selecting a project in Submittal Exchange, tabs appear under the header. An Alert icon will
appear to the right of the project name if applicable.

The icon will show number of alerts. The alert icon is expanded to display the alert details when
a user first logs in, or when an alert is added or modified.

Note: Alerts include project milestones, required project actions, system
announcements, etc.

Log Progress

After selecting a project in Submittal Exchange, tabs appear under the header. A percentage
icon displays to the right of the project name in Submittal or Closeout logs. This is the Log
Progress icon. Select the icon to see the percentage of items that have been submitted and
reviewed.

This counts all expected items within the log you are currently in (i.e. Submittal or Closeout). It
also counts one item for each section that does not display any expected items.

Note: If there are no expected items anticipated for a section, best
practice is to remove that section from the project.

The % Submitted measurement indicates the percentage of expected items within the log for
which information has been uploaded to the project.
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The % Reviewed measurement indicates the percentage of the expected items within the log
that have made it through the entire review process and have been sent back to the
Subcontractors for the project.

Savings Calculator Icons

After selecting a project in Submittal Exchange, tabs appear under the header. The Preferences
tab contains project preferences. The Savings Calculator icons appear to the right of the
project name. The icons appear under a You have saved title.

You have saved
£ 0@ @
Use these savings calculators to see what your organization has saved by using the system.
Trees-See the number of trees saved by using Submittal Exchange.
Time-See the shipping days saved by using Submittal Exchange.

Money-See the amount of money saved by eliminating the creation and shipping of documents
by using Submittal Exchange.

Navigating Submittal Exchange Project Logs

The top of each log has options you can use to customize your view.

Note: Not all users will see all menus, tabs, or options. Access to some
features depends on which role or team you are on.

1) Show Paging/Show All-Use the pagination toggle to see items in pages or to show them on
one scrolling page.

2) Actions-Use the Actions menu options to expand or collapse sections and categories, lock
columns, and set up in-column filters.

3) Log Display-Use the Log Display toggle button to view only the most recent information or
the full log for all items.

4) View-Use the View toggle button to view only My Activity or All Activity.

Note: The system shows the last view selected, even when a user logs
out. A user can manually switch back and forth between My Activity and
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All Activity.
5) Div-Use the Div (division) drop-down to limit the view of your content to the selected
division.
6) Filter-Use the Filter drop-down to limit the view of your content to the selected filter.
Tip:

An alert message is displayed if the log display contains hidden columns. Select the Table
Settings icon within the alert to show hidden columns and to hide additional columns.

Show Paging

When logged into Submittal Exchange, select a project. If a log has multiple pages, the content
can be displayed in two ways.

» Pages-The list of pages appears below the log name. Below the log name is a Show All link
that allows you to change to the scrolling view.

» Scrolling-All the items in the log appear on a single scrolling screen. Below the log name is
a Show Paging link that allows you to change to the pages view.

Actions Menu

When logged into Submittal Exchange, select a project. The Action drop-down menu appears
above the table. It shows options to expand or collapse sections and categories, lock columns,
and set up in-column filters.

Collapse All Action
When logged into Submittal Exchange, select a log from the Project Log drop-down.

Select Collapse All from the Actions menu above the table. The table only shows the latest
activity for each item. The purpose of the Collapse All feature is to show only the latest activity
for each item in a log. Use the collapsed view to focus on recent activity.

Notes:

= The default setting is Collapse All.

= Switch back and forth between Collapse All and Expand All
manually. The setting remains on the current view unless manually
switched.

= The Expand All feature presents the item history, which can
overwhelm a user with history that is no longer relevant.

Expand All Action

When logged into Submittal Exchange, select a log from the Project Log drop-down.
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Select Expand All from the Actions menu above the table. The table shows all activity for each
item. Use the expanded view to see the item history.

Notes:

= The default setting is Collapse All.

= Switch back and forth between Collapse All and Expand All
manually. The setting remains on the current view unless manually
switched.

= The Collapse All feature presents only the latest activity for each
item.

Lock/Unlock Columns Action

When logged into Submittal Exchange, select a log from the Project Log drop-down. The
Actions menu includes either Lock Columns or Unlock Columns, depending on your current
selection.

Select Lock Columns from the Actions to show the Submittal # or RFI #, the Type, and
the Description columns no matter how far to the right you scroll.
» Select Unlock Columns to scroll through columns freely.

Note: Switch back and forth between Lock Columns and Unlock
Columns manually. The setting remains on the current view unless
manually switched.

Show/Hide Filters Action
When logged into Submittal Exchange, select a log from the Project Log drop-down.

» Select Show Filters from the Actions menu above the table. A Filter row appears below the
table header.
Enter a value in the Filter field of any column to see only the rows that contain that value.

» Select Hide Filters from the Actions menu above the table. The Filter row disappears from
the table.

Download Multiple Files Action
When logged into Submittal Exchange, select a log from the Project Log drop-down.

1) Select Download Multiple Files from the Actions menu. The Download Multiple Files
page appears.

2) Select the sections or the files you want to download.
You can also use Select All or Deselect All to choose files to download.
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Note: Subcontractors can only download files from sections or
categories to which they have been added.

3) Select Download Now. The system sends an email when the download completes. The
email includes instructions for downloading a ZIP file.

Note: The download process runs every 30 minutes. The system does
not allow you to download more files before your first request is finished.

View User Access

See who can access the log with the View User Access feature. When logged into Submittal
Exchange, select a log from the Project Log drop-down. Select View User Access from the

Actions menu. The View User Access window appears. It shows the user email and the role
the user is assigned.

Notes:

= Any user with access to the log can view the user list.

= The View User Access feature is only available with standard views
of a log type.

Viewing Related Links

To view the related links associated with project items:

1) Select a project and choose the Project Logs tab from the Header menu.
2) Select the Links icon under the Related To column.
3) Choose a link to open the page.

Adding and Managing Related Links

To add and manage related links:

1) Select a project and choose the Project Logs tab from the Header menu.
2) Select the Links icon under the Related To column.

3) Select Manage.The Manage Related To Links page displays.

4) From the Manage Related To Links page, select Add Links.

5) Choose a log and section from the drop-down menu.

6) Select the Add button to link specific sections.

7) Select Save Links.

Tip:

To remove links, select the Remove button under the Action column.
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Log Display Options

When logged into a project on Submittal Exchange, each log has two display options which can
be adjusted using a toggle button located to the right of the Actions menu.

Note: The display option not currently selected is also included in the
Actions menu.

The Display Full Log option contains the full log of activity for all items in that log.

v v v v Vv

This view contains all the information about a review.

It displays who, what, and when something was uploaded or reviewed.

It is used to verify where a Submittal is in the review flow.

The Full Log can be used to locate and view a file other than the most recent file.
Documents can be uploaded and reviewed in this display.

The Display Summary option contains only the most recent information/review within each
section or category.

»

The Status column shows whether an item is still needed or who has reviewed/submitted
the most recent document.

The Date column shows the most recent date of an upload or review.

The Type column shows the most recent electronic file, or it shows the item was sent as a
hard copy, rather than submitted electronically.

The Action column shows the action/review code for the document once a review has been
completed by a Design Team member.

Documents can be uploaded and reviewed in this display.

Note: If the Type column shows PENDING, the item is in a review stage
during which you cannot view the file. This provides the same checks
and balances as the paper-based system.

View Options

When logged into Submittal Exchange, select a project. The View option is located above the
table. In the drop-down, choose between My Activity and All Activity.

»
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My Activity shows only the sections and categories to which you are assigned regardless of
which log is selected. These are the sections and categories you can upload and review.
Each has a green upload arrow in the Upload column.

View All Activity shows all sections and categories within a log. This is a read-only full
project view for all trades. It's available for coordination purposes; you can only upload to
sections and categories to which you are assigned.

Note: The system shows the last view selected, even when a user logs
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out. A user can manually switch back and forth between My Activity and
All Activity.

Division Options

When logged into Submittal Exchange, select a project. The Div: option is located above the
table. The filter will limit the view of the log content to a specific division based on the filter you
choose. The available divisions are listed in the drop-down menu.

Filter Options

When logged into Submittal Exchange, select a project. The Filter option is located above the
table. The filter will limit the view of the log content to specific items based on the filter you
choose.

Filter Options

Note: When you log in to Submittal Exchange for the first time this filter
defaults to show all items on the project. This is the standard view.

Submittals Pending Design Team-This filter shows only items pending the Design team. Items
include those submitted by the General Contractor/Construction Manager that have not been
reviewed by the final reviewer.

Submittals Pending Final Review-This filter shows items that do not have a Consultant
reviewing and those for which Consultants have completed their review.

Reviewed Submittals-This filter shows items that have been fully reviewed by the Design team
and returned to the Construction team.

Submittals Needed-This filter shows items that have yet to be submitted by the Construction
team.

Submittals Pending GC-This filter shows items that Subcontractors and Suppliers/Vendors
have submitted which are awaiting the General Contractor/Construction Manager review, as well
as items pending release by the General Contractor/Construction Manager back to the
Subcontractor or Prime Contractors.

Updated Last 7 Days-This filter shows items that have been updated in any way within the last
7 days.

Deleted Items-This filter shows items that have been deleted by a project team member or
items that have been removed from the logs via the Sections & Categories tab.

Note: Once you select a filter option, you must manually change it back
to the None to see the standard view.
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Adding a Category or Section to a User's Account

When logged into Submittal Exchange, select a project and go to the Project Team tab.

Note: If a user cannot upload to a particular category or section, the
user's settings may not include it.

1) Select the team member: choose the user's name or email address. The Edit Team
Member page appears.

2) To edit sections:
» Choose Select from list and select sections.
» Select Done.
3) To edit categories:
» Choose Select from list and select sections.
» Select Done.
4) Select Save once the necessary sections or categories have been added.

Notes:

= Multiple team members can be edited at once.
= A Project Leader can make adjustments to all team members.

= Architects can make adjustments to users at their company as well as
their Consultants.

= General Contractors or Construction Managers can make
adjustments to users at their company as well as their
Subcontractors.

= All other parties should reach out to their main point of contact on the
project.

Changing an Office Location or Address

Users can edit their current office address or add additional office locations. Users can also
assign which users from their company are associated with each location. When logged into
Submittal Exchange follow these steps:

1) Select My Account under your name in the upper right hand corner of the page to see your
Account Info.

2) Choose the appropriate location from the Office drop-down list.
3) Select Save changes.

Notes:

= Submittal Exchange can remove addresses upon request.

= You can also select the Company Info tab to change your office
location and address.
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Changing/Editing Office Addresses in Submittal Exchange

When logged into Submittal Exchange, select Company Account under your name in the upper
right hand corner of your screen, to see your Company Info.

Edit Office Address

1) Select the appropriate location from the Office drop-down list.

2) Select the Edit button.

3) Enter the new address in the Address field.

4) Enter the new city in the City field.

5) Enter the new state in the State field.

6) Enter the new ZIP code in the Zip field.

7) (Optional) Enter phone number and fax number in Phone and Fax fields.
8) Select Save changes.

Add Office Address
1) Select the New button to the right of the Office field.

2) Enter a name for new location in the New Office field.
3) Follow steps 2-7, above.

Controlling Email Notifications

When logged into Submittal Exchange, select a project and go to the Project Team tab.
1) Select the email address for the team member you wish to edit. The Edit Team Member
page appears.

2) Select or deselect the Email Notifications under the Member Email Settings, until only the
notifications the team member would like to receive are selected.

3) Select Save.

= An Architect, General Contractor, or Construction Manager acting as
the Project Leader can edit anyone's email settings.

= An Architect not acting as the Project Leader can edit any Design
Team member's email settings.

= A General Contractor or Construction Manager not acting as the
Project Leader can edit the email settings for anyone in their office as
well as any Subcontractor.

= A Subcontractor cannot adjust email settings; contact the General
Contractor or Construction Manager to edit email settings.

= An Owner cannot adjust email settings; contact the Project Leader or
Submittal Exchange Technical Support.
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Deleting and Renaming Files in My Library

When logged into Submittal Exchange, select My Account under your name in the upper right
hand corner of your screen. On the Account Info page, select Click to manage your My
Library Files. The My Library dialog box appears.
» To delete a file, select the Delete option in the Action column.
» A confirmation box appears. Select OK and the file will be removed.
» Torename a file, select the Rename option in the Action column.
» Change the file name in the dialog box provided.
» Select OK, and the file saves with the new name.

Notes:

= This is a personal option, not a company option.

= The My Library feature is available to store documents in a personal
library on Submittal Exchange.

Editing Multiple Team Members
When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select team members:
» If all team members need editing, select all. Doing this will place a check mark in the box
for each user.
» If only a few team members need editing, select applicable team members.

2) Select the Manage Users drop-down button and choose Edit Selected Users. The Edit
Team Members page appears.

3) Select Add or Remove from the drop-down list next to:

» Logs, choose Select from list, and select logs

» Sections, choose Select from list, and select sections

» Categories, choose Select from list, and select categories.
4) Select Done when the edits for each have been completed.

5) Select Add or Remove from the drop-down list next to Email Notifications, then select
notifications.

6) Select Save.

Editing Team Members
When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select a team member.

2) Select i Gear > Edit. The Edit Team Members page appears.

3) From the Member Access Settings section, you can add or delete logs, sections,
categories, and phases.
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a. Choose Select from list, and select logs, sections, categories, and phases.
b. Select Done when the edits for each have been completed.
4) From the Member Email Settings section, select the following:
a. From the Frequency of Email Notifications drop-down menu, select how frequently you
want the user to receive email notifications. The default option is User Default.
b. Select the Email Notifications you want the user to receive.

5) Select Save.

Adding a Team Member to Multiple Projects

Use the Add User To Multiple Projects link to add a user to multiple projects within your
company. You can clone the access and roles that you have on projects to a new or existing
team member. From this page you can easy on board a new user to multiple projects.

Note: This option is not available to administrators.

1) Navigate to the Company Account.
2) Select the link Add User To Multiple Projects link.

3) The Add User To Multiple Projects page is displayed. The left pane displays your account
details, your projects, and the role you have for each project. The right pane displays a list of
users who are part of your company.

4) From the right pane, select the user who you want to give project access.

5) From the Assign Project section, you can select the projects and the role you want to
assign to the user. From the Assign Projects section, use the checkbox to select individual
projects or use the Select All checkbox on the header row to select all projects.

6) From the Clone Team Member Settings section, you can choose your role or clone a team
member's role setting. The role that you have in the project is automatically selected for the
user.

Tips:

= The Assign Project section displays two numbers, the first number is the number
of projects the selected user has access to and the second number is a count of
project that will be added For example, if it displays Assign Project (1+18), the
selected user is part of 1 project and the + 18 indicates that 18 projects will be
added to the selected user. If the second number is 0, then there are no projects
that can be added.

» The projects displayed in gray require no action from you.

= A crossed out project name indicates that selected user and you both have access
to the same project. Projects that are displayed in gray and have the checkbox
grayed out are projects for which you don't have access, but the selected user has
access.

»= The projects highlighted in green are the projects you can take action on.

7) Select Preview to view the changes.

8) Select Save.
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How to Adjust the Frequency of Email Notifications

When logged into Submittal Exchange, select My Account under your name in the upper right
hand corner of your screen, to see your Account Info.
1) Under Email Settings, email frequency options are:

» Immediate: This is the default setting. This setting will send emails within 5 minutes of
activity on the website.

» 1 hour, 2 hours, 4 hours, or 24 hours (digest options): These settings will send one
notification per period selected. Each notification contains all email activity within that
specified time frame.

» Message Center: This setting means no automated notifications based on activity on the
website will be sent to your email inbox. Instead, messages be held within the Message
Center link on Submittal Exchange.

Note: The frequency option will apply to all projects you are involved
with on Submittal Exchange.

2) (Optional) Expand the Change Settings for Individual Projects section to adjust the timing
for individual projects.

» The same email frequency options are available in a drop-down list.
» Projects set to the same frequency will be contained within one email.
3) Choose Reminders.

» Submittal Exchange sends reminders for upcoming or past due items that need your
attention.

» Select the days of the week to receive these reminders.
4) Select Save changes.

How to Create a Public Plan Room on a Design Project

When logged into Submittal Exchange, select a project and go to the Preferences tab to create
a Public Plan Room for a Design Project.

1) Below the list of existing logs, select Add New. An Add New Log dialog box appears.

2) Enter a name in the Log Name field (ex. Plan Room, Bid Documents).

3) Forthe Log Type select Type 6, which is a Design posting log, no review (Design
Documents, Planroom, Drawings, Specs or similar)

4) Choose Enable Public Planroom.
» The URL will fill in the beginning of the Project name / Log name.
» Adjust the auto-filled URL portions if needed.

5) (Optional) Enter a password for log.

6) Select the categories to be included in this log.
» Common Categories: Drawings, Specifications, Addenda

7) Select Save.
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How to Set Submittal Turn-Around Time on a Project

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Scroll down to the bottom of the page.

2) Inthe Required Item Turnaround field, enter in the desired number of turnaround days.
3) Use the drop-down list to select Business or Calendar days.

4) Select the gray Save Changes button.

5) Select OK when the Settings updated successfully dialog box appears.

Note: If this setting is selected, the system sends reminder notifications
when the due date has passed and the action has not been taken.
Reminder emails are sent daily after the due date passes until the item is
reviewed.

How to Update the Displayed Project Number to Your Internal Project Number

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Scroll to the bottom of the page and locate your company settings area.
2) Inthe Internal Project Number field, enter your company specific number.
3) Select the Save changes button.

Note: This changes the project number at the top of the Submittal
Exchange page. This number will appear only for people in your
company.

Log Display Speed
When logged into Submittal Exchange, go to the Preferences tab.

1) Under View select Display one division or category at a time.
2) Click the Save Changes button.

Notes:

= This will change logs to view one division or category at a time.

= To switch from one division or category to the next, you will click on
the appropriate links at the top left of the log.

Uploading Project Specification Manual

You can upload a specification manual which will be used by the Oracle Submittal Exchange
Setup team to set up your project. To upload the project manual:

1) Select the Help icon, and choose Contact Us.
2) From the Contact Us page, select the Upload Project Manual button.
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3)

4)
5)

6)

7)
8)
9)
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Select if you are an enterprise customer. The required fields differ based on the selection
you make.

Enter all the required fields marked with a red asterisk.

Optional. From the Copy Existing Project field, select Yes if you want to create this project
based on an existing project.

a. From the Select Project to Copy field, start entering the name of the project you want to
copy. The system will display projects that match the name you entered. You can also
select archived projects that are up to 180 days old.

b. Select a project.
Optional, displays only if are an Enterprise customer.
a. Choose a project value.

b. Select if you want to invite a project lead to the project. Start entering the name of the
project lead and the system will displays users whose name matches the name you
entered.

Optional. Enter any additional notes.
Select Browse to choose a specification manual, or drop and drag the file.
Select Upload to submit the file the Oracle Submittal Exchange Setup team.
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What is Submittal Exchange for Design?

Submittal Exchange for Design is a comprehensive collaboration tool for improving efficiency
and communication during the design phase of a project.

Some of the things that Submittal Exchange for Design provides are:

» Comprehensive design document sharing (drawings, specs, models, etc.)

» Collaborative whiteboard and automatic synchronization of large files

» Automatic notifications and detailed upload and download histories

» Seamless transition into construction phase features when design is completed
Note: To schedule a demo please go to
www.oracle.com/applications/primavera/products/submittal-exchange/in
dex.html and select Submittal Exchange for Design. From there you

can select Schedule Demo to complete the form to receive a
personalized presentation of Submittal Exchange for Design.

What is an Archive?

A project is archived when:

» All files that must be uploaded have been uploaded.
» All files that must be reviewed have been reviewed.
» The project is ready to be removed from the website.

An archive is a copy of the project information you view when looking at each page.
This includes:

» All files that you see when viewing each log.
» The dates and action codes surrounding those files.
» The project team.

The Project Leader completes the archive process on Submittal Exchange.

Note: For all other requests, contact Submittal Exchange Technical
Support.

What is the Discussion Forum?

The Discussion Forum on Submittal Exchange allows commenting and discussion about an
item without changing the document itself.
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1) When the Discussion Forum is enabled, a gray comment icon appears to the left of every
item description within the log.

2) This feature is set up when creating the log.
» Comments and replies can only be made if a user's role allows it.

Notes:

= If the discussion icon is gray, no comments have been made on the
item.

= [f the discussion icon is red, there is a comment on the item with no
response.

= If the discussion icon is green, all comments have at least one
response.

What is the Form Editor?

Use the Form Editor button when you have requested Submittal Exchange to set up your
company's forms on the system. Typical company forms may include Transmittal Covers and
Requests for Information (RFI).

The Submittal Exchange system can automate a portion of the information on the form. Forms
are created as PDFs, and you can attach PDF files when using the Form Editor.

If you would like to replicate your company forms on the system or if you would like to use one of
our standard forms, please email an electronic version of the forms to your Client Relationship
Consultant (CRC) at Submittal Exchange. Forms can be in a Word Document, Excel
Spreadsheet, or PDF file.

What is the Review Flow for Log Type 3 (RFI Log)?

When logged into Submittal Exchange, select a project and go to the appropriate log. The steps
are listed as column headings in the Display Full Log view.
1) A Subcontractor can upload the initial RFI document.

» A Subcontractor can fill out their General Contractor or Construction Manager's RFI form
using the Form Editor if the Form Editor is made available.

2) The General Contractor or Construction Manager then reviews the Subcontractor's file. The
General Contractor can either:

» Respond directly to the RFI, sending it back to the Subcontractor with the answer and
stopping the item from further review.

» Upload the reviewed file (with or without changes) and send it on to the Design Team.

3) When a Consultant is involved, the Consultant reviews the General Contractor or
Construction Manager files and uploads the reviewed file (with or without changes).

» Multiple Consultant reviews may be performed within this step if there are more
Consultant companies that need to review the same RFI.
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4) The Architect then reviews the General Contractor or Construction Manager's file or the
Consultant's file, by either releasing the item without further comment or by uploading the
reviewed file (with or without changes).

» The Architect can skip the Consultant reviews altogether, meaning that Step #3 can be
skipped entirely. Certain projects may not include Consultants.

5) The General Contractor or Construction Manager then reviews the Architect's file, and
releases that file back to their Subcontractors.

6) The Subcontractor downloads the file.

Note: A Custom Review column can be added in between the
Consultant and Architect review. This often occurs when the Facility
Owner is actively involved in the review process.

What is the Review Flow for the Log Type 4 (RFP Log)?

When logged into Submittal Exchange, select a project. The steps are listed as column headings
in the Display Full Log view.
1) A Consultant can upload the initial RFP document.

» The Architect can also do an initial upload, skipping the Consultant altogether.

2) The Architect then reviews the Consultant's file or uploads a new document. The Architect
can:

» Replace the Consultant's upload.
AND/OR
» Upload their reviewed file (with or without changes).

3) The Subcontractor can review the Architect's file by uploading the reviewed file (with or
without changes).

» Multiple Subcontractor reviews may be performed within this step if there are more
Subcontractor companies that need to review the same document.

Note: Most logs with this review flow do NOT include Subcontractors
within the review on Submittal Exchange.

4) The General Contractor then reviews the Subcontractor's file by uploading their reviewed file
(with or without changes).

» The General Contractor can skip the Subcontractor reviews altogether, meaning that
Step #3 can be skipped entirely.

5) The Project Team can then download the final reviewed file.

What is the Review Flow for Log Type 5 (Posting-Only Logs)?

Log Type 5 logs do not have a review flow.

Note: ASI, Bulletin, or Meeting Minutes are examples of Log Type 5 or
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Posting-Only Logs.

» This log type is used for logging and distributing information.
» The ability to post to these logs is set by the Project Leader within the Preferences tab.

» Project team members are able to download the posted documents at their convenience by
selecting the appropriate file icons.

What is the Review Flow for the Log Type 8?

When logged into Submittal Exchange, select a project and go to the appropriate log. The steps
are listed as column headings in the Display Full Log view.
1) An Architect can upload the initial document.
» The General Contractor can do an initial upload, skipping the Architect altogether.
2) The General Contractor then reviews the Architect's file. The General Contractor can:
» Replace the Architect's upload.
AND/OR
» Upload their reviewed file (with or without changes).

3) The Consultant then reviews the General Contractor's file by uploading their reviewed file
(with or without changes).

» Multiple Consultant reviews may be performed within this step if there are more
Consultant companies that need to review the same document.

Note: Most logs with this review flow on Submittal Exchange do NOT
include the Consultants in the review.

4) The Architect then reviews the Consultant's file by uploading their reviewed file (with or
without changes).

» The Architect can skip the Consultant reviews altogether, meaning that Step #3 can be
skipped entirely.

5) The Project Team can then download the final reviewed file.

Adding Phases to Expected Items

Note: If the Phase column is not visible in the Display Full Log view,
contact your Client Relationship Consultant (CRC) to set up this feature.

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select a section, and click Edit below the Expected items in this section box to the right.
2) Enter the appropriate phase for each item.

Note: Each phase that you enter must match the phase abbreviation in
the Preferences tab.

3) Select Save.
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4) Repeat for each section.

5) Navigate to the Display Full Log view to ensure that each Expected Item falls under the
correct phase.

Adding Punchlist Comments

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Inthe left column click Edit.
2) Underneath the Comments column a box appears where you can add your comment.

Note: Your role determines when you can add a comment.
Subcontractors can only add a comment during their review. Architects
and General Contractors can add comments at any time.

3) Once you have added your comment, you can change or update other columns.

4) In the left column select Update. The comment is saved and appears in the Comments
column.

Can | Upload More Than One File to One Submittal Line Iltem?

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the Submittal line item to which you need to upload a file.
2) Select the green upload arrow in the Upload column. A dialog box appeatrs.

Single File
Select one non-PDF file.

I. Select the Browse button to upload a file. A dialog box appears. It says, Only PDF files
automatically combine into one file. Other file types upload individually. This is
simply a reminder.

2. Choose the file. Select Open. The Submittal Exchange dialog shows the file name.
3. Select Save.

Multiple Files

Select multiple PDF files for one submittal line item, which are combined into one large PDF file
once uploaded.

I. Select the Browse button to upload a file. A dialog box appears. The Submittal Exchange
dialog shows the file name.

2. Choose multiple documents by holding down the CTRL key on your keyboard as you
choose the documents.

Note: If you need to remove one of these PDF files after you have
selected it, select the red X next to the file name, and it will be removed.

3. Select Save.
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Zip File
Select a Zip file.

I. Select the Browse button to upload a file. A dialog box appears.
2. Choose the Zip file. Select Open. The Submittal Exchange dialog shows the file name.
3. Select Save.

Note: This is helpful if you need to upload more than 10 PDFs to one
line item. You can zip as many PDF files as you want as long as they are
all in one Zip file. You can also zip different file types into one Zip file and
upload it; for example, a Zip file might include a PDF and Word
document.

Notes:

= Submittal Exchange has a 100 MB size limit for files uploaded to a
single line item.

= [f experiencing an error when uploading multiple files to one line item,
it is likely due to the security settings on one of the individual files
being uploaded. Each individual file must have no security settings in
order to upload correctly.

Deleting a Submittal Item

When logged into Submittal Exchange, select a project and go to the Submittal Log.

1) Select the Display Summary view.

2) Select the description of the item to be deleted. A dialog box appears, detailing information
about the submittal.

3) Select the Delete button. The system prompt Are you sure you want to delete this
submittal? If you want to delete the submittal entirely, select OK.

4) After selecting OK, indicate the reason for the deletion and select Delete.

5) The system refreshes and the deleted item is removed from the project. An email notifies the
Project Leader of the deletion.

Notes:

= Only General Contractors or Construction Managers, Architects, and
Project Leaders on Submittal Exchange have can delete.

= When an item is deleted, it is moved to the Deleted Items filter.

= If an item has been inadvertently deleted, you can retrieve the item by
going to the Deleted Items filter. Select the description of the item
you deleted, and select Undelete. When an item is undeleted, it
returns to the project and section from which it was initially deleted.
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Editing an Item Pending Review in the Punchlist Log

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Select Edit in the column to the left.
» The line item will expand.
» The items you can edit will display within text fields.
2) Edit these items by updating the text fields.
» If the text field has a drop-down list, select the arrow and choose from those options.

3) Once updates are complete, select Update in the column to the left. Your edits will then
display in the log.

Emailing a Team Member from the Project Team Tab

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the name of the team member to whom you wish to send an email.

2) Select o) Gear > Email.
3) A new message window from your email provider will appear. The team members selected
will display in the To field of the message.

4) Fill out the Subject. Enter your message into the body of the email then select Send.

Tip:
To email multiple team members, select the team members and select Email Selected Users
from the Manage Users drop-down button.

Notes:

= This option does not work if your internal email software is Lotus
Notes.

= Email providers have limitations on the number of characters allowed
within the To field of emails. If you have used too many characters,
you will receive a warning telling you: We are unable to email this
many team members at one time. Please deselect some users
and send multiple emails. Make the necessary adjustment to send
the email.

= A red indicator is displayed for undelivered email addresses in the
Project Team page.

Managing Custom Stamps

You can view and manage custom stamps for your company from the Manage Custom stamps
page.

Add New Custom Stamp

1) Select the Company Info page.
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2) Select the Manage Custom Stamps button.
3) Select Add.
4) Drop and drag files or browse to select files.
5) Select Save.

Note: For best results select transparent stamps.

Managing Stamps
To edit a stamp:

1) Select the Company Info page.

2) Select Manage Custom Stamps button.

3) Select the Edit icon.

4) From the Edit Custom stamp page, you can edit the stamp text or replace the stamp.
5) Select Save.

To delete a stamp, select the Delete icon.
To download a stamp, select the Download icon.

Moving Items from One Log to Another

When logged into Submittal Exchange, select a project and go to the log from which you want to
remove the item.

1) Select the blank space directly to the right of the item to move. Doing so highlights the item
in yellow. Choose multiple items by holding down the CTRL key on your keyboard as you
choose the items.

2) Right click on the highlighted area. A list of options appears.

3) Select the Move option. A Move items dialog box appears.

4) Use the Move to log field to select the log to which the item should move.
5) Use the Move to Section field to select a section.

Notes:

= [f you selected multiple items to move, you should only choose a
section if all items are moving to the same section.

= If you selected multiple items to move, when you choose Move to
same section(s) the items will move to the selected log. Each item
will bring its current section assignment with it.

6) Select Save. The dialog box closes and the item no longer appears in the log.
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External Tools

Using Adobe Acrobat Flattening Tool

Acrobat supports flattening, but it is not included in the default menus. A JavaScript program is
needed to enable the feature. Follow these steps to enable the feature:

1) Exit from Acrobat if it is open.

2) Find the flatten.zip file.

Note: The zip file is included in the Submittal Exchange Knowledgebase.
Search the Knowledgebase at
https://www.submittalexchange.com/help/KB.aspx https://www. for
Flattening tool.

3) Open the zip file.
4) Save the flatten.js file to the JavaScripts folder in the Acrobat directory on your computer.

» If you have Acrobat 7.0, the directory is C:/Program Files/Adobe/Acrobat
7.0/Acrobat/Javascripts/.

» If you have a different version of Acrobat, the version number will change as needed.
5) Restart Acrobat.

6) There will now be a new menu item on the Document menu in Acrobat, Flatten PDF. Select
Flatten PDF when you have a PDF open. All the comments and markups are flattened into
the content of the file, so they cannot be changed or removed.

Note: This should only be done after you are 100% complete with your
markups.

7) After you have flattened a PDF, select Save.

Notes:

= PDFs are flattened by default, when uploaded to Submittal Exchange.

= We have tested the Flatten PDF feature in both Acrobat 7.0 and 8.0.
It should also in theory work for older versions as well (for example,
6.0), however that version has not been tested.

Checking PDF File Security

Verify PDF security settings in Adobe Acrobat. These settings typically are set when the file is
originally created. Settings are created with Acrobat Pro or Standard (not Reader).

1) Open the PDF in question with a PDF tool (Adobe Acrobat Reader, Standard, Pro or
equivalent).

2) Go to the top right corner and select the File menu.

3) Select Properties. A dialog box appears.

4) Select the Security tab.
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5) Review Document Security and Document Restrictions Summary to find features
Allowed or Not Allowed.

Note: Submittal Exchange's form editor and multiple file merging tools
require that the PDF allow Document Assembly and Changing the
Document. If Not Allowed, Submittal Exchange will simply upload the
first document in the submittal.

Creating a Zip File

Zipped files are significantly smaller than unzipped files and allow you to combine multiple files
into one single file.

Create a Zip File
1) Select the Start button on your computer.
2) From the Windows Explorer view, select the directory location of the files.

3) Hold down the CTRL key and select the files you want to include in the zip file. Release the
CTRL key when you have selected all the files to include in the zip file.

4) Right click on highlighted files.
5) Select Send To->Compressed Zip file.

This will create a zip file in the location of the original files.

Downloading Dropbox

1) Goto www.Dropbox.com http://www.dropbox.com/
2) Select Download Dropbox.

3) Select Run to run Dropbox installer.

4) Select Yes to allow changes.

5) Follow set up instructions.

6) Select| do not have an account and select Next.

7) Fill out account information, read, and select | have read and agree to the Terms of
Service.

8) Select Dropbox size.

9) Choose set-up type and select Install.
10) (Optional) Watch tour or skip it.

11) Select Finish.

How to Clear Browser History and File Cache

Note: These steps only apply to users with using a Windows operating
system.

1) Select Start in the lower left hand corner of your screen.
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2) Select Control Panel.
3) Select Internet Options. An Internet Properties window appears.
4) In the General tab, the middle of the window has a section called Browsing history.

5) Select Delete. A Delete Browsing History window appears. It shows six browsing history
options.

6) Select all the browsing history options that must be deleted.

7) Select Delete.
Depending on how long it has been since the history was cleared, a new dialog box may
show progress bar. Deleting the browser history could take anywhere from a few seconds to
a few minutes. The window disappears automatically when the history is deleted.

8) Close the Delete Browsing History window and close the Internet Options window.

How to Update Java

Java is a necessary application in order to use Submittal Exchange's PDF Editor.

1) Go to http://www.java.com/en/download/manual.jsp
http://www.java.com/en/download/manual.jsp.

2) Select the file for your operating system.

3) Follow the directions given by the site to install the latest version of Java.

You may need to restart your computer after you have completed the installation steps to enable
the Java.

Note: The newer version of Java requires both the 32-bit and 64-bit
versions to be installed on a 32-bit computer.

Not Receiving Emails from Submittal Exchange

To ensure that you receive email notifications that are being sent, please do the following:

1) Add Submittal Exchange to your safe-sender/allow list (more commonly called your allow
list) on all company firewalls. Your IT consultant may need the following information to add
Submittal Exchange to the allow list:

» Email Account (may only need to add the domain):
notifications@submittalexchange.com

» |IP Address: 50.16.187.18

» If Submittal Exchange is already on your allow list, but the emails are not received it's
possible the IP Address was not added along with the email/domain. Adding both the
email/domain and IP Address may allow users to begin receiving all emails from
Submittal Exchange.

Note: You will only receive new notifications, so you will need to wait
until a new one is generated. To see notifications that were sent
previously, log into Submittal Exchange, and select the Message Center
on the top right. All notifications that have been generated will appear
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are included in the Message Center.

If you are still not receiving emails after making the suggested adjustments, please contact
subex-help_ww@oracle.com or call technical support at 1-800-714-0024, extension 2.

Uploading a Stamp to Adobe Acrobat

To create the stamp:

1) Save the PDF version of your stamp to your computer.
2) Open a new file within Adobe Acrobat software on your computer.
a. Select: Tools > Comments > Stamp Tool > Create Custom Stamp.
Select Browse to locate and select your PDF stamp file.
Select OK.
In the Category field, select Dynamic for the stamp and name your stamp.
Select OK.
Your stamp has now been saved in your Adobe Acrobat tools and is ready for future use.

® oo o

To use this stamp:

1) Open the document in Adobe Acrobat.
a. From the toolbar select: Tools > Comments > Stamp Tool > Dynamic.
b. Select Your stamp.
Locate your stamp and click on it.
Place your stamp on the document. Resize your stamp as needed.
c. Save the file for future use.

Uploading Files to My Library from Dropbox

When logged into Submittal Exchange, select your name in the top right hand corner of the
page, and select Manage My Library.

When logged into Submittal Exchange, select My Account under your name in the upper right
hand corner of your screen, to see your Account Info.

1) Onthe Account Info page, select Click to manage your My Library Files. The My Library
dialog box appears.

2) Select Choose from Dropbox. A Dropbox dialog box appears. Allow Submittal Exchange
to connect with your Dropbox.

» Import.
»  Sign into Dropbox.

3) Select the file or files you wish to import.
» Select Copy files to my Library.

Once the import is complete, close the window. This item is now available in your library for
future uploading.
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Note: The My Library feature is available to store documents in a
personal library on Submittal Exchange.

Uploading to Hightail
You can access the Hightail Upload screen in one of the following ways:

1) If you are not logged in to Submittal Exchange:

» Go to the Submittal Exchange website www.submittalexchange.com
(www.submittalexchange.com).

» Select the Upload Project Manual link in the bottom right-hand corner.
2) If you are logged into Submittal Exchange:

» Select on the Help link at the top right of any page in Submittal Exchange and select
Support Home.

» From the Support Home tab, select the link under Upload Specifications for a New
Project.

3) Theicon noted Upload Specifications/Project Manual or Send It will take you to the
following URL: https://www.hightail.com/u/SubmittalExchange7110897
(https://www.hightail.com/u/SubmittalExchange7110897)

4) Complete the following:
a. Enter Name, Email Address, Subject, and Message.
b. Select a file to upload from your computer by using Browse.
c. Once you have located the file to upload, select Open.
d. Once all files to upload are selected, select SEND IT.

What is a PDF Printer/Converter?

A PDF Printer/Converter is a free, external tool that converts any file type into a PDF.

A PDF Printer/Converter converts your current documents of any type into PDF format.

It acts like a virtual printer; you print a document as if you were sending it to a normal office
printer, but the PDF printer saves it as a PDF file instead.

» It works with any program that would normally allow you to print (i.e. word processors,
spreadsheets, internet browsers, CAD files, or any other type).

» Please keep in mind that there are many varieties of PDF converters and printers available
online, and PDF995 is one good, free option.

How to Download/Install a Free PDF Printer/Converter

1) Go to www.pdf995.com (www.pdf995.com).
2) Select Downloads towards the top of the screen.
3) Download the Pdf995 Printer Driver.
» Select the Run option to install within the File Download dialog box.
4) Download the free converter.
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» Select the Run option to install within the File Download dialog box.
5) This will place an additional printer in your computer's available printers.

Note: This is one of many PDF printer/converters available.

How to Use a PDF Printer/Converter

1) Open the document that needs to be converted to a PDF.
2) Use the Print command just like you normally would in any program.

Note: The File > Print drop-down menu is a common method.

3) Inthe print options, select the PDF printer you have installed, and select Print when ready. A
newly created PDF will be "printed" to your screen, which you can save to your computer.

Note: If you are using a free converter, you may see advertisements
display on your screen. This happens because the software is free. It
should not watermark or affect your PDF document.

What are the Recommended Browsers for Submittal Exchange?

Submittal Exchange functions best when using Mozilla Firefox.

Submittal Exchange has multiple functionalities that use Java. For these to work, a user
needs to be in a Java compatible browser.

» Submittal Exchange is developed for use in the current version of, and two previous versions
of Mozilla Firefox.

Note: Submittal Exchange works with other internet browsers, but some
functionality may not be available.

What Kinds of Files Can Be Uploaded to Submittal Exchange?

Any user has the ability to upload virtually any type of file with the following exceptions:

» The file cannot be an executable file, meaning the file cannot have a .exe on the end of the
file name. These types of files are essentially computer programs, so these would not be
appropriate to upload to our document sharing site.

» You cannot upload a hyperlink to another website into the Browse box.

Notes:
= PDFs are the most common file type on Submittal Exchange,
because they can be viewed with widely available software.

= When uploading more unique file types, such as DWF or REVIT files,
please be conscious of the fact that the rest of your project team may
or may not have the necessary software available to view these file
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types.

Why Won't Files Upload? (Common Reasons)

»

The file must be uploaded from your computer.
The file must be saved on your computer or accessible on a network through your computer.
The file is too large.

» File size is limited to 100 MB. To upload files larger than 100 MB, select the My Library
link and select Choose from Computer. Browse to select you file and click Upload
Files.

» If you are scanning a document, set your DPI to 150-200.
Security settings on PDF. To check security settings:
I. Open the PDF.

2. Select Properties under the File menu in the top right corner of the PDF. A dialog box
appears.

3. Select the Security tab. If anything within this tab says Not Allowed, the file may not
upload.

Uploading multiple file types to one submittal.

» When submitting PDFs, you can upload up to 10 files.

» When submitting any other file type, you can only upload 1 document.
Using the Form Editor.

You can only attach PDFs when using the Form Editor in Submittal Exchange.

Generating Reports - Iltems Needed

The Items Needed report shows any expected items that have yet to be submitted in specific
logs in Submittal Exchange.

When logged into Submittal Exchange, select Reports in the upper right hand corner of the
screen to run a report.

1)
2)
3)

4)
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In the Project field, select the project on which you need a report.
In the Log Type field, select the log.
In the Built-In area, select tems Needed. Report-specific sections appear.

» Further narrow your report criteria by selecting your date preferences using the Filter and
Recent Activity drop-down lists.

» Use the Sort By drop-down list in the Sort section to sort the report by the columns
available in the current log.

Once you have selected the appropriate criteria, select Save as Defined Report to save this
report as Custom, or choose Run Report.

Notes:

= Save as Defined Report allows you to name and save the generated
report in the Saved area. It will then be available anytime you open
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the Reports page for this project.

= Run Report generates the report in a new page. Select Print (printer
icon near the top of this page) OR select Export (computer disc icon
near the top of this page) to save this on your computer or network in
Excel.

Generating Reports - Open Items

When logged into Submittal Exchange, select Reports in the upper right hand corner of the

screen to run a report.

1) Inthe Project field, select the project on which you need a report.

2) Inthe Log Type field, select the log.

3) Inthe Built-In field, select either Print Project Log or Export Project Log to Excel.
Report-specific sections appear.

» The new sections present several sorting and filtering criteria for the report. Under
Report Type, select Open Items.

» An Output Format section is included.

4) Once you have selected the appropriate criteria, select Save as Defined Report to save this
report as Custom, or choose Run Report.

Notes:

= Save as Defined Report allows you to name and save the generated
report in the Saved area. It will then be available anytime you open
the Reports page for this project.

= Run Report generates the report in a new page. Select Print (printer
icon near the top of this page) OR select Export (computer disc icon
near the top of this page) to save this on your computer or network in
Excel.

Generating Reports - Punchlist Log

When logged into Submittal Exchange, select Reports in the upper right hand corner of the
screen to run a report.

1) Inthe Project field, select the project on which you need a report.

2) Inthe Log Type field, select the Punchlist log.

3) Inthe Built-In field, select either Print Project Log or Export Project Log to Excel.
Report-specific sections appear.

» The new sections present several sorting and filtering criteria for the report.
» An Output Format section is included.

4) Once you have selected the appropriate criteria, select Save as Defined Report to save this
report as Custom, or choose Run Report.
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Notes:

= Save as Defined Report allows you to name and save the generated
report in the Saved area. It will then be available anytime you open
the Reports page for this project.

* Run Report generates the report in a new page. Select Print (printer
icon near the top of this page) OR select Export (computer disc icon
near the top of this page) to save this on your computer or network in
Excel.

Generating Reports - Reviewed Items

The Reviewed Items report shows any items that have been completely reviewed in a selected
log.
When logged into Submittal Exchange, select Reports in the upper right hand corner of the
screen to run a report.
1) Inthe Project field, select the project on which you a report.
2) Inthe Log Type field, select the log.
3) Inthe Built-In field, select either Print Project Log or Export Project Log to Excel.
Select Print Project Log
Report-specific sections appear.
» Inthe Report Type drop-down list under the Options section, select Reviewed Items.
»  Further narrow your report criteria using the other drop-down lists under the Options
section.
Select Export Project Log
Report-specific sections appear.
» Inthe Items Viewed field, select either My Activity or All Activity.
» Inthe Report Type field, select Reviewed Items.
» Further narrow your report criteria using the other drop-down lists under the Options
area.

4) Select a column name in the Sort By drop-down list under the Sort section to sort the report
by the columns available in the log.

» Use the Order drop-down list to select the sort order.

5) Once you have selected the appropriate criteria, select Save as Defined Report to save this
report as Custom, or choose Run Report.

Notes:

= Save as Defined Report allows you to name and save the generated
report in the Saved area. It will then be available anytime you open
the Reports page for this project.

= Run Report generates the report in a new page. Select Print (printer
icon near the top of this page) OR select Export (computer disc icon
near the top of this page) to save this on your computer or network in
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Excel.

How to Adjust the Number of Punchlist Items in the Punchlist Log

When logged into Submittal Exchange, select a project and go to the Punchlist log.

Underneath the Collapse Al | Expand All views, a drop-down list includes 50, 100, 250, or All

options.
» 50 shows 50 punchlist items.
» 100 shows 100 punchlist items.
» 250 shows 250 punchlist items.
» All shows all punchlist items.

Note: Once you have selected a number from the drop-down list, the
number of items in the Punchlist log will remain constant unless changed
again.

How to Delete a Photo Gallery

When logged into Submittal Exchange, select a project and go to the appropriate log.
If you are the owner of the gallery or uploaded the gallery:

1) Select Edit to the right of the gallery name.
2) At the top right corner of the gallery photos, select Edit gallery settings.
3) Select Delete. A dialog box appears.

4) Select Ok within the dialog box to permanently delete the entire gallery of photos from
Submittal Exchange.

Notes:
= |f a photo gallery is deleted, it is removed from the website. It cannot
be recovered.

= If you are not the owner of the gallery, please contact the owner to
remove gallery.

How to Download Photos

When logged into Submittal Exchange, select your project and go to the Photos log.

1) Select Download Multiple Files. The Download Multiple Files page appeatrs.
2) Select the Galleries that include the photograph files you want to download.

Note: All the files in the selected galleries are included in the download.

3) Select Download Now. You will receive an email when the download completes. The email
includes instructions for downloading and extracting photos from a ZIP file.
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Note: The download process runs every 30 minutes. The system does
not allow you to download more files before your first request completes.

How to Set Turn-Around Time on a Specific Log

When logged into Submittal Exchange, go to the Preferences tab.

1) Inthe Project Logs field, select the log for which to set the turnaround time. The Edit Log
Settings dialog box appears.

2) Inthe Turnaround drop-down either:

» Select Project Default - The default is the Required Item Turnaround on the
Preferences tab.

» Select Other - Two drop-down fields appear next to the Turnaround field. Select the
number of days in the first field and choose between Business or Calendar days from
the second.

3) Select Save.
Note: This will set reminder notifications for the selected calendar days

or business days. A reminder will be sent a day prior to the due date and
daily thereafter until an item is reviewed.

How to Use Budget Columns

When logged into Submittal Exchange, select a project and go to the appropriate log.
1) Select the description of the item to which you need to add the budget information. A dialog
box appears.
2) Select Edit item detail or Edit Detail in the top right corner.
3) Enter the amount.
4) Select the Status.
» Approved
» Not Approved
» Pending
» Under Review
» Budgeted
5) Select Save Budget Details.

Note: Based on the amount and statuses entered, the total calculates at
the top of the log.
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How to Use the Discussion Forum

When logged into Submittal Exchange, select a project and go to the appropriate log.
To add a comment:

1) Select the discussion icon to the left of the Description.

2) A dialog box presents a text box to enter comments. After comments have been entered,
select Add Comment.

» Adding comments changes the color of the discussion icon and adds an additional red
icon indicating a comment has been added. Everyone that has access to the category or
section sees all comments and responses.

To respond to a comment:

1) Select the discussion icon to the left of the Description.
2) Select the comment to which you are responding. The dialog box changes.
3) Enter areply.
4) Select Save Reply.
A notification email is generated to the original authors when a reply has been made to their

comment.
Notes:
= If the discussion icon is gray, no comments have been made on the
item.
= If the discussion icon is red, a comment on the item is awaiting a
response.

= If the discussion icon is green, all comments on the item have at least
one response.

How to Use Sort Options in the Punchlist Log

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Select any of the column titles to sort the Punchlist log by that column.
» Select the same column title again to reverse the sort order.

2) Filter options are in the right hand corner of the page.
» Four options are available to refine the display of the log.

» Select the Filter to sort by. The page refreshes and only displays items that meet the
Filter criteria.

Note: The Filter remains selected for this log. To reset the filter or see
all information associated within this log, change the Filter to None.
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Managing your Access Settings

You can manage your access settings from the Edit Team Member page. You can add/remove
your access to logs, sections, and categories, and set your email preferences.

Notes:

= You can only edit your access and not for other users.

= |f you have removed access, you cannot add it back. Contact your
Project Lead or your Administrator if you would like to regain access.

To edit your access settings:

1) Select the Project Team tab.

2) Select your name to view the Edit Team Member page.

3) From the Manage Access Settings section,make your changes.
4) Select Save.

Rejecting the Final Reviewer's Response

If the final reviewer's response to an item is not acceptable, it can be returned to the reviewer.
When logged into Submittal Exchange, select your project, go to the Project Logs tab, and
select the appropriate log.

Select the Return link under the Returned to Subs column. A dialog box appears.
From the dialog:
I. Verify Submittal Number, Description, and Date item was returned fields.
2. Add comments for the Final Reviewer to be included in the email notification.
3. (Optional) Attach documentation.
4. Select Reject Response.
An email is sent to the final reviewers assigned to the section and category. Comments entered

in the dialog section are included in the email. The reviewer's previous status is removed from
the log. The reviewer must upload a new review.

Reviewing Upload History

When logged into Submittal Exchange, select Company Account under your name in the upper
right hand corner of your screen to see your Company Info or select My Account under your
name in the upper right hand corner of your screen, to see your Account Info.
1) Select the Upload History tab.
2) Select Show Detail.

» The upload history for the last three months displays.

» The date, time, and user who uploaded to each project is included in the table.
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Note: You can only review upload history for your company's
documents.

Seeing the History of Punchlist Notifications

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Select Email Options above the log.
2) Select Show History.

» Select the plus button to the left of the Date, Recipients, or Message Content to view
additional information.

Sending a Submittal via Email

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the blank space to the right of the item to which you want to send a link. Doing so
highlights the item in yellow.

2) Right click on the highlighted area. A list of options appears.

3) Select the Email option. An Email Link dialog box appears. Either:

» Use the Email Link dialog box to enter an email address.
Note: If you enter email addresses for people who don't have a Submittal Exchange
account, they will be presented with the Submittal Exchange Terms of Use. Non-users
must agree to the Terms of Conditions to download items.

» Select from a listing of all the members on your project team. Hold down the CTRL key
on your keyboard as you select multiple team members from this list.

4) (Optional) Select Copy me on the email to send a copy to yourself.

5) (Optional) Add comments to go with the email. Text entered in the Comments field appears
in the body of the email.

6) Select Send email. This sends an email with a link to the most recent PDF file of the item
selected.

Note: You may only use this function on sections/categories listed within
My Activity.

Sending All Updates for Punchlist Items

When logged into Submittal Exchange, select a project and go to the Punchlist log.
1) Select Email Options. A Punchlist Log -- Email Options area appears.
2) Select Send All Updates.

» Below the Email Options, a Messages section shows when the last email was sent and
how many items have been updated since that naotification.

3) Select Send.
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Note: This feature is available only to General Contractors, Architects or
Project Leaders.

Sending Select Activity for Punchlist Items

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Select Email Options above the log header. A Punchlist Log- Email Options area
appears.

2) Select Send Select Activity.

3) Select the items about which you want to send emails.

4) Select the users to whom you want to send emails.
» Add Additional Comments as needed.

5) Select Send to send the email.

Notes:

= At least one item must be selected to Send Select Activity.

= Only General Contractor, Architect and Project Leaders can send out
select activity within email.

Uploading a Photo Gallery

When logged into Submittal Exchange, select a project and go to Photos log.
1) Select the green Upload new gallery arrow which is displayed directly above the category
column. The Add New Gallery page appears.
2) Complete the following information:
» Gallery Name
» Category (automatically populated)
» Description
» Gallery Owner (automatically populated)
3) Select Save. A Java application launches and a dialog box appears.
4) Browse for photos to upload.
» An entire folder of photos can be uploaded at one time.

5) Select the green upload arrow to your upload selected photos. An email naotification is sent
that includes links to the uploaded files.
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Note:

= Only double-click on an item if you want to upload all.
= Photos must be saved as JPEG of GIF files.

= Files cannot be uploaded from email; they must be saved on your
computer.

= Shortcuts will not work. You need the direct path to the location of the
photos.

Uploading Files to My Library from Your Computer

When logged into Submittal Exchange, select Manage My Library under your name in the
upper right hand corner of your screen.

A My Library dialog box appears.

1) Select Choose from Computer. The dialog box changes.
2) Select Browse and upload your file. The file name displays in the dialog box.
» Repeat this step as needed.
3) Select Upload Files. This item is now available in your library for future uploading.

Note: The My Library feature is available to store documents in a
personal library on Submittal Exchange.

Uploading to a Design Log

When logged into Submittal Exchange, select a project and go to Log Type 6.
1) Select the green upload arrow next to the category to which you are uploading. A dialog box
appears.
2) Either:
» Drag-and-drop files into the gray upload area
» Hold down the CTRL key on your keyboard to select multiple files to upload.
Once the files appear in the upload window, they will be listed individually.
3) (Optional) Adjust the category for each by selecting from the Category drop-down list.
4) (Optional) Update the Description.

Note: When first uploaded, the Description is the file name.

= You can change the description.
= You can add remarks.

5) Select Save to upload the files to the log.
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Notes:

= File sizes affect the amount of time it takes to complete the upload
process.

= Each file is uploaded.

= Each uploaded document generates an email.

Uploading to the Punchlist Log

Yes

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Select the green upload arrow next to the item to which you are uploading. A dialog box
appears.

2) Select Browse and locate the file on your computer.
» Once the file is located, select Open. The file name appears in the dialog box.

3) Select Save. The file appears in the File column of the Punchlist log.

Using the Form Editor on Submittal Exchange

Note: If you use the PDF Editor tool integrated into Submittal Exchange,
be sure to select Form Editor first.

When logged into Submittal Exchange, select a project and go to the appropriate log.
1) Select the green upload arrow next to the category to which you are uploading. A dialog box
appears.

2) Fill out the pertinent information for the upload. If there is a form on the system, there will be
a Form Editor icon next to the Browse button.

3) Select the Form Editor icon. A dialog box appears.
4) Fill out the fields for the form.

Note: If you would like to preview what the form will look like select the
Preview button.

5) (Optional) To add supporting PDF documents to the form, go to the bottom of the dialog box
and locate the Browse button.

» Locate the file on your computer and select Open.

Note: You will not be able to browse to emails. If there is a document in
your email that you wish to attach, go to your email and save it to your
computer's hard drive. Then you will be able to browse to the document.

6) Select Save to upload to the log.
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Note: Forms are customized specifically for each company.

= If you add a form to Submittal Exchange, anyone from your company
will have access to the form.

= If you are a General Contractor setting up an RFI form, the
Subcontractors on your project will be able to use your RFI form as
well.

= [f you do not have forms set up on Submittal Exchange yet, contact
your Client Relationship Consultant (CRC) and they can work with
you to accomplish this.

Who Has Viewed an ltem?

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the description of the item. A detail dialog box appears.

2) In the dialog box, select the item in question.

3) Select Downloads below the uploaded file.

4) A Download History dialog box shows who downloaded the file.

Notes:

= |f this is blank, someone viewed the item from a link in an email.

= This option is available for General Contractors/Construction
Managers, Consultants, Architects, and Owners.

Who Reviewed an Iltem?

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the description of the item. A detail dialog box appears.
2) Inthe dialog box, select the item in question.
3) Select Notification below the uploaded file. A Notification History dialog box appears.

» At the top right pane of the Notification History, the name of the person who initiated
the email notification is listed.

Notes:
= The Notification History dialog box shows everyone who received
the email notification.

= The Notification History dialog box includes the View Full Email
Here links to view the contents of each email notification

= This option is available for General Contractors/Construction
Managers, Consultants, Architects, and Owners.
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Who Uploaded an Item?

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the description of the item. A detail dialog box appears.
2) Inthe dialog box, select the desired user role.

3) Select Uploads below the uploaded file.

4) An Upload History dialog box shows who uploaded the file.

Notes:
= The Upload History dialog box shows the date and time of the
upload in Central Standard Time (CST).

= The Upload History dialog box shows the action codes and remarks
if applicable.

= This option is available for General Contractors/Construction
Managers, Consultants, Architects, and Owners.

Why Can | Only See PENDING on a Line Item?

When logged into Submittal Exchange, select a project and go to the appropriate log.
If you are a Construction Team member

The Consultant's reviewed file will appear as PENDING in the log until the final review by the
Architect has been completed. This allows the Architect to review and approve the Consultant
comments, markups, and action codes before it is available to the General
Contractor/Construction Manager and the Subcontractor. As soon as the Architect's final review
is uploaded the Consultant's reviewed file will be available to view and download as well.

If you are a Design Team member

The Subcontractor's file will appear as PENDING until the General Contractor/Construction
Manager has uploaded their review to the log. This allows the General Contractor/Construction
Manager to determine that the Subcontractor upload is correct and complete before passing this
information along to the Design Team. Once the General Contractor/Construction Manager has
uploaded their review the Subcontractor file will be available to view and download as well.
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Adding a Category

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.
1) Select Categories at the top of the box with the sections listing.

2) Select Add New below the box. A dialog box appears, allowing you to enter multiple new
categories at one time.

3) Enter the categories and select Save.

Adding a Category to a Log

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.
1) Select Categories at the top of the box with the sections listing.

2) Select Add New below the box. A dialog box appears, allowing you to enter multiple new
categories at one time.

3) Enter the categories and select Save.
4) Go to the Preferences tab, and select the log to which you want to add the category.
» Select the appropriate boxes for the new category.

5) Go to the Project Team tab, and select team members who require access to the new
category.

» Add the category to their settings.

Note: Team members require access to upload a category or log or
receive notifications about documents in a category or log.

Adding a Log

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.
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1) Select Categories at the top of the box with the sections listing.

2) Select Add New below the box. A dialog box appears, allowing you to enter multiple new
categories at one time.

3) Enter the categories and select Save.

4) Go to the Preferences tab.

5) Select Add new under Project Logs. An Add New Log dialog box appears.
» Enter a Log Name.
» Selectalog Type.
» Select the categories needed within the log.

Note: Categories can be rearranged or new categories can be added.

= Drag-and-drop category name to re-order.
= Use the Add New Category link to create add a new category.

6) If new categories were created for the log, go to the Project Team tab.
» Add the new categories to the team members that will be involved with the log.

Notes:

= Only a Project Leader can add a log.

= After adding a new log, you will need to edit the Project Team to add
the log to individuals that need to see it, upload to it, review it, and
receive emails about it.

= Contact your Submittal Exchange administrator to enable the Public
Planroom.

Adding Custom Columns to a Project Log

Project Leaders and SE/CSEA Admins can add up to five custom columns to a project log.

Notes:

= You cannot add multiple custom columns to Type 7,9, and 10 log
types.

= All changes made to custom columns are tracked and can be viewed
in the Event History.

= Custom columns are also displayed in the public view for Log Type 6.

= Use the Location column to identify the placement of a custom
column.

1) Select your project and select Preferences.
2) From the Project Logs section, select a log.
3) From the Edit Log Settings page, under Custom Columns, click + Add New Column.

4) Enter a name, location and select the column type.
5) Select the users who can edit the column.
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6) Select the Include on upload to add the column when the submittal is being uploaded in
logs.

7) Click Add.
8) Click Save.

Editing or Deleting Custom Columns

To edit a custom column on a Project Log:

1) Select your project and select Preferences.
2) From the Project Logs section, select a log.

3) From the Edit Log Settings page, under Custom Columns, click the Edit Custom Column
icon next to the column you want to edit.

4) Update the settings.

5) Use the Select and drag icon to change the location of a column. You can use the Location
column to identify the current placement of a custom column.

6) Click Save.
To delete a custom column from a project log:

1) Select your project and select Preferences.
2) From the Project Logs section, select a log.

3) From the Edit Log Settings page, under Custom Columns, click the Remove this Column
icon next to the column you want to delete.

4) Click OK to confirm the deletion.

Notes:
= You cannot change a File Uploader column type to any other type or
change other column types to File Uploader.

= All changes made to custom columns are tracked and can be viewed
in the Event History.

= Custom columns are also displayed in the public view for Log Type 6.

Adding a New Specification Section

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Below the list of current specification sections, select Add New.
2) Add specification number and title.
3) Select Save.
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Note: This functionality is only available to Project Leaders.

Adding Expected Items

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the Specification section in the left-hand table. This will display current expected
items for that section in the right table.
2) Select Edit below the Expected Items table (right table).

3) Select standard expected items or enter text in the blank fields. Pre-numbering and required
submittal dates can also be set here.

Importing Expected Sections and Items

You can either import using an Excel template or you can upload your specification manual in
PDF format to create submittal items within the chosen log. When a PDF file is uploaded, the

system scans the file and displays the expected items and sections for you to review. You can
preview the expected items and sections before importing it.

To import sections and items:

1) Select the Sections & Categories menu and select Import Data.

2) Select a log you want to import the sections and categories into.

3) Select if you want to import a specification manual in PDF format or if you want to download
a template.

a. Select Download Template to download the sample template. Follow the instruction on
the template to create your import file and save it. Skip this step if you are uploading a
PDF manual.

b. Select Browse to upload project manuals as PDF or select the template you modified in
step 3a.

4) Select Next. The Import Preview page is displayed. If you uploaded a specification manual
in PDF format, the system automatically scans the file and pulls in the specification
submittal names and numbers to create submittal items.

5) Review the items and select the check box next to sections you want to import and click
Import Export Items.

Tip:
» Select the Import Sections Only checkbox to view only the section number and name, the
description of each section is not displayed.

» Select the Edit icon on the Import Preview page to make changes to the sections. Select
Edit Multiple to make changes to multiple sections at the same time.

» Select the Delete icon on the Import Preview page to delete a section.
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Adding Specifications Sections to a Project

Note: This task can only be performed by the Project Leader on
Submittal Exchange. If you need to add sections to a project and are not
a Project Leader, contact a Project Leader. You can find a Project
Leader in the Project Team tab.

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select Add new under the existing Sections box. An Edit Sections dialog box appears.
2) Enter a Section Number and Section Title for each section to be added to the project.
3) Select Save at the bottom of the dialog box. The system adds the new sections.

4) Verify that any new sections appear in the Sections & Categories tab or in the Submittal
Log.

Note: You may also add expected submittal items under the Sections
and Categories tab. Refer to Adding Expected Items for instructions.

Editing Expected Items

To edit expected items:

1) When logged into Submittal Exchange, select a project.
2) Select the Sections & Categories tab.

3) Select any section from the left-hand table. This will display current expected items for that
section in the right table.

4) Select Edit below the Expected Items table (right table).
The Edit Expected Items dialog box displays.
5) Make the required changes and select Save.
Tip:
To select or de-select all items, select the Select all rows or the Deselect all rows check box
next to the Log column.

Editing Multiple Expected ltems

You can edit multiple expected items at the same time using Set Dates.

1) When logged into Submittal Exchange, select a project and go to the log.

2) From the Actions drop-down menu, select Edit Expected Items. OR Select the red Edit
Dates link below the Due Date column

3) Select the check box next to each item you want to edit and select Edit Selected.

86



Project Leaders on Submittal Exchange

4) The Edit Selected Expected Items dialog box is displayed.
5) Make changes to the Date Expected, Phases, Supplier/Manufacturer, or any custom column.

6) Select the Override existing data check box if you want to override existing data. Unless
this check box is selected, data will not be overwritten.

7) Select Apply.
8) Select Save.

Allowing Teams/Companies to Upload to a Posting Only Log

When logged into Submittal Exchange, select a project and go to the Preferences tab.
1) Inthe Project Logs field, select the log to which the Team/Company should post. A dialog
box appears.

2) Inthe Who can post area, select the organization names, the organization types, or the
users who can upload to the log.

3) Scroll to the bottom of the window and select Save.

Note: Only users who have the categories listed within their settings in
the Project Team tab will be able to upload.

Backing Out an Architects Review

Project Leaders can use Edit Detail to back out of a review.
When logged into Submittal Exchange, select a project and go to the Submittal Log.

Note: When using Edit Detail, most automation is disrupted and the
appropriate email notifications may not go to the team members.

Backing out a Final Review

1) Select the description of the submittal that needs to be backed out. A dialog box appears.
2) Select Edit detail in the upper right corner.
3) Select Architect Review.
4) Remove the following by highlighting the text and using the delete key on your keyboard:
» Date returned to General Contractor
» Action code
» Remarks, if entered.
5) Change the file type to Hardcopy.

6) Select Return to Subcontractor. Remove the Return to Subcontractor date displayed in
this area.

7) Select Save.

Backing Out a Consultant Review
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1)
2)
3)
4)

5)
6)
7)

8)
9)

Select the description of the submittal that needs to be backed out. A dialog box appears.
Select Edit detail in the upper right corner.

Select Consultant Review.

Remove the following by highlighting the text and using the delete key on your keyboard:
» Date reviewed

» Action code

» Remarks, if entered.

Change the file type to Hardcopy.

Select Architect Review.

Remove the following by highlighting the text and using the delete key on your keyboard:
» Date returned to General Contractor

» Action code

» Remarks, if entered.

Change the file type to Hardcopy.

Select Return to Subcontractor. Remove the Return to Subcontractor date displayed in
this area.

10) Select Save.
Backing Out a GC Review

1)
2)
3)
4)

5)
6)
7)

8)
9)

Select the description of the submittal that needs to be backed out. A dialog box appears.
Select Edit detail in the upper right corner.

Select Submittal from GC.

Remove the following by highlighting the text and using the delete key on your keyboard:
» Date received from GC

» Date Sent to Architect

» Remarks, if entered.

Change the file type to Hardcopy.

Select Consultant Review.

Remove the following by highlighting the text and using the delete key on your keyboard:
» Date Sent to

» Date Reviewed

» Action code

» Remarks, if entered.

Change the file type to Hardcopy.

Select Architect Review.

10) Remove the following by highlighting the text and using the delete key on your keyboard:

» Date returned to General Contractor
» Action code
» Remarks, if entered.

11) Change the file type to Hardcopy.
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12) Select Return to Subcontractor. Remove the Return to Subcontractor date displayed in
this area.

13) Select Save.

Changing a Section Name

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the section you would like to rename.

2) Select the Edit button at the bottom left of the list of sections. A dialog box appears.

3) In the dialog box, make the necessary changes.

4) Select Save.

Changing a Submittal to a Closeout or a Closeout to a Submittal

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the part of the submittal you wish to change. A dialog box appears.
2) Select Edit detail at the top right corner of the dialog box. A new dialog box appears.

3) Select the Document type from the item information at the top of the dialog box. You can
change the Document type to Submittal or Closeout.

4) Select Save. The entire item is moved from the Submittal to the Closeout log or vice versa,
depending upon your selection.

Note: If the Closeout Log is a posting only log (No Review Flow),
please contact Submittal Exchange Help or the consultant assigned to
your project.

Changing an Expected Item from a Submittal to a Closeout or from a Closeout to a

Submittal

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the section that requires adjustment to the submittals or closeouts. This section
number and name are highlighted in blue.
2) Below the box to the right, select Edit.

3) Using the drop-down list to the left of the Item Description, change Submittal to Closeout
or Closeout to Submittal as necessary.

4) Select Save.
5) Repeat as needed.
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Changing Email Notifications

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the email address for the team member you wish to edit.
2) Select or de-select the notifications as needed.
3) Select Save.

Changing Log Types

Once a log has been created on Submittal Exchange, a change to the type of a log is not
allowed. Instead, a Project Leader is able to create a new log.

When logged into Submittal Exchange, go to the project and select the Preferences tab.

1) Below the list of logs, select Add new.
2) Name the log.

3) Select the type of log.

4) Select categories to include in the log.

Note: Before deleting an old log, verify that there are no files within it. If
there are existing files, save them all on your local drive so you will be
able to upload them to the new log.

5) Upload the new files to the appropriate categories, with the correct dates/information.

6) Once the new log is created with the files uploaded, go into the old log and delete all the
files.

7) Email subex-help_ww@oracle.com to request removing the specific log from your project.

Note: The new log must be added to all team members, within the
Project Team tab, that will need access to the log.

Delete a Section

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the section to be deleted. If there are expected items listed, be sure to delete them
first in the smaller box on the right after selecting the section.

2) Select Delete below the list of Sections. A dialog box appears.

3) Confirm that you want to delete the section. Click Ok if you wish to proceed.

Notes:

= Submittal Exchange will NOT allow you to delete sections if there are
current submittals in the section.

= Submittal Exchange will NOT allow you to delete a Section if there
are submittals or expected items listed within that section in the
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Deleted Items filter.

Deleting a Log

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Within the list of logs, select the log that needs to be removed. A dialog box appears.
2) Within the dialog box, select Remove from project at the bottom.

Notes:

= Only a Project Leader can delete a log.

= Alog cannot be removed from Submittal Exchange if files have been
uploaded to the log.

= If there are files currently in the log, go to the log to delete, then follow
the steps above.

Exporting Log Data

To export the entire log data into Excel:

1) Navigate to your project.
2) Select a log.
3) Select the Export Log button.
The log data is exported, and an event is logged in Submittal Exchange.

Tip:
You can use the print functionality within Excel to print the log data.

How a Project Leader Can Add a Custom Column

When logged into Submittal Exchange, select a project and go to the Preferences tab.
1) Select the log that you would like to edit from the list of Project Logs. An Edit Log Settings
dialog box appears.
2) Select Show Custom Column. The section expands.
a. Enter the column name.
b. Select the location in the log where the column should appear.
c. (Optional) If the column should show dates, choose the Date Function check box.
d. Choose which roles or users can edit the columns.
3) Select Save at the bottom of the window.
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How a Project Leader Can Edit Punchlist Status Options

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Select the log that you would like to edit.
2) Select the Edit Status Options button below the Log Type.
» The current Status Options will be displayed.

Note: Any item with a red asterisk is a required item, however you may
still edit the text that is displayed.

3) Edit, remove, or add new Status options.

4) If you would like to add additional options, click the +Add Additional Status Options link
and type in the text you wish to appear.

» Select Done, at the bottom of the list when complete.
5) Select Save at the bottom of the window.

Note: Subcontractors will only be able to select the second status option
that is available to subcontractors upon their completion.

How a Project Leader Can Edit the Reminder Turnaround for a Punchlist Log

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Select the Punchlist log that you would like to edit from the list of Project Logs. A dialog
box appears.

2) Locate the Reminder Turnaround area in the middle of the dialog box.
» The Reminder Turnaround may be set to count only business days or all calendar days.
» There is no minimum on the number of days you must select.

3) Select Save at the bottom of the window.

Notes:
= Reminder notifications are sent daily, based on this setting while the
item is marked as New.

= Only Project Leaders may edit Reminder Turnaround for the
Punchlist log.

= Reminders and timeframes for the Punchlist log are separate from
other Turnaround time-frames set on the Preferences tab.

How a Project Leader Can Enable or Disable Automatic or Manual Updates for a

Punchlist Log

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Select the Punchlist log that you would like to edit from the list of Project Logs. A dialog
box appears.
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2) Below Reminder Turnaround, Update Emails displays in bold.
3) Select the email option needed.
» Automatic Updates are set to one of three different frequencies described in the log
» Manual Updates means no automatic emails will be generated from the log activity.
4) Select Save at the bottom of the box.

Notes:

= Only Project Leaders may change Update Emails for the Punchlist
log.

= Emails and timeframes for the Punchlist log are separate from any
other timeframe set on the Preferences tab or Account Info area for
other logs.

How a Project Leader Can Request a New Archive

When logged into Submittal Exchange, select a project and go to the Preferences tab.

Note: Prior to a final archive, verify all documents have been uploaded
that need to be and all documents have been reviewed that need to be.

1) Below the list of logs, select Request archive.
2) From the Download Existing Archive page, select Request New Archive.

3) From the New Archive Request section, select the Log Detail (views) to include in the
archive.

4) Select the logs to include in your copy.

» Only logs that contain documents are on the list.
5) Select any of the Additional Options as needed.
6) Select Submit request.

The system sends an email with a link to download a zipped file of your archive.

If you run into any issues while extracting the zip file, go to www.7zip.me to download a free
extractor.

Notes:

= Additional instructions are in the email.

= If this is a final archive, notify Submittal Exchange to remove the
project from the website, to ensure your archive is a true final copy.

= Forward the email to other team members who need a copy of the
project information.

= An event is logged when archives are requested and downloaded.
You can view the event from the Event History page.
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How to Use Bulk User Import to Add Multiple Users to a Project

Use the Bulk User Import option to add multiple users to a project during project creation. Only
Admin or Project Leaders can access this option. You can either manually enter multiple users in
the grid, or use an Excel file to import multiple users.

To bulk import users into a project:

1) Select your project and navigate to the Project Team tab.

2) From the Manage Users drop-down button, select the Bulk User Import option. The Add
User page is displayed. You can add multiple users from an Excel file or use the grid to add
users.

3) To add multiple users using the grid:

a. Select Add User. A new row is added to the grid. For each user, enter the user email,
company , role, title for that user.

b. Double click the row and enter an email address for the user.

c. Select the drop-down menu under Company to select the company the user belongs to.
You can also select New Company to add a new company. If you select New Company,
you can enter a name under the Company Name column.

d. From the Project Role drop-down, select a role.

e. Enter atitle for the user.

f. Select Edit on the Logs, Sections, and Categories columns, to make your selection.

g. Click Next. The system validates your entries. Errors or missing information are displayed

in red.
4) To add multiple users using the file option:
a. Select Upload File. The Upload Users via File page is displayed.
b. Select the Download Template link from Step 1 to download the Excel template that is
specific to your project.
c. Follow the instruction on the template to set up your import file.
d. Click Browse and select the import file you updated in Step c.

e. Click Next. The system validates your entries. Errors or missing information are displayed
in red.

5) Review and fix the errors displayed under the Errors/Warnings column.
6) Click Verify to confirm the errors have been fixed.

7) Click Next.

8) Confirm your additions and select Save.

9) Select the Email password to individual checkbox to have the system send default
passwords to the users you just added to the system.

Tips:
» To edit multiple rows using the grid, use the checkbox to select multiple rows and click Edit
Selected.

» To delete a user using the grid, select the gear icon next to each row and select Delete. To
delete multiple users, use the checkbox to select multiple rows and click Delete.
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How Can | Hide Team Members from Other Team Members?

When logged into Submittal Exchange, select a project and go to the Preferences tab.

1) Inthe Project Team drop-down list (which is directly above the Project Logs list), select the
drop-down arrow.

2) Select Keep team members confidential.

3) Select Save changes directly below the Project Logs list.

4) A dialog box shows Settings updated successfully. Select OK.

Note: This allows only team members from their own company on the
project as well as the Project Leader to be visible.

How to Delete a Punchlist Item

When logged into Submittal Exchange, select a project and go to the Punchlist log.

1) Find the Punchlist item that should be deleted.
2) Select Delete to the left of the item that should be deleted. A dialog box appears
3) Confirm that you want to delete the item. Click Ok if you wish to proceed.

4) The system refreshes and the deleted Punchlist item is removed from the project. An email
is generated to the Project Leader alerting them of the deletion.

Notes: When a Punchlist item is deleted it will be moved to the Deleted
ltems filter.

If a Punchlist item has been inadvertently deleted, you can retrieve the
Punchlist item by doing the following:
= Go to the Deleted Items filter.

= Select the description of the item you deleted and then select
Undelete.

How to Edit a Milestone in Submittal Exchange for Design as a Project Leader

When logged into a Submittal Exchange for Design, select a project and go to the Preferences
tab.
1) Select the Project Milestones heading below the list of logs.
2) Select the milestone to edit. A dialog box appears.
3) Change or set the desired fields below:
» Date of completion of milestone
» Number of days prior to completion date for Alerts.
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4) Select Save.

How do | Set Project Milestones for Construction Projects

To set project milestones:

1) Select your project.
2) From the top-navigation bar, select Preferences tab.
3) Select the Project Milestones checkbox.
4) Select the Add new milestone date link. A dialog box displays
5) Within the dialog box, set the fields below:
» Percent of completion for the project
» Milestone description
» Date of completion of milestone
» Number of days prior to completion date for alerts
6) Select Save.

Notes:
= These milestones will appear within each log once the countdown to
the due date begins.

= These milestones are visual reminders and do not sent email
notifications for pending work.

= To edit a milestone, select a milestone, and change the field values.

How to Remove a Team Member from the Project as the Project Leader

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the team member to be removed.

2) Select o) Gear > Remove. The Delete Members dialog window appears.

3) Select Delete to confirm deletion. The screen refreshes and the team member is no longer
included in the project team.

Note: If you are removing a user because the user is no longer
employed, please contact Submittal Exchange Technical Support to
have their access to Submittal Exchange removed.

How to Renumber Submittals as the Project Leader

When logged into your project on Submittal Exchange, select a project, go to the Submittal
Log, and find the appropriate section that needs its number changed.

1) Select the description of the submittal. A dialog box appears.
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2) Inthe upper right hand corner of the dialog box, select the option entitled Edit submittal
detail.

3) Highlight the number within the Submittal number text box and change it.

4) Select Save at the bottom of the window. The window will close and your submittal will
appear with its new number.

Note: Subsequent submittals will continue following the numbering
pattern predetermined in the Preferences tab of the project.

How to Set a Milestone in Submittal Exchange for Design as a Project Leader

When logged into a Submittal Exchange, select a project and go to the Preferences tab.

1) Select Project Milestones below the list of logs.
2) Select the milestone you want to set or edit. A dialog box appears.
3) Within the new dialog box change or set the fields below:
» Percent of design completion for the project
» Milestone description
» Date of completion of milestone
» Number of days prior to completion date for Alerts.
4) Select Save.

Notes:

= These milestones will appear within each log once the countdown to
the due date begins.

= These milestones are visual reminders and do not send email
notifications for pending work.

How to Switch Roles on a Project

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the email address for the user who is currently listed under the incorrect role. An Edit
Team Member page appears.

2) Select the correct role from the Project Role drop-down list.

3) Scroll down to the bottom of the Edit Team Member window and select Save.

Note: The Project Team page appears. The team member is listed
under the correct role.

How to Undelete an ltem

When logged into Submittal Exchange, select a project and go to the appropriate log.

97



Design Team User Guide

1) Select Deleted Items from the Filter drop-down list at the top right corner. Only deleted
items appear in the log.

2) Locate the item that needs to be undeleted.
» Select the specific item, below the Description column, you want to undelete.
» A dialog box appears.
3) At the bottom of the new dialog box select the Undelete button. A dialog box appears.
4) Confirm that you want to delete the item. Click Ok if you wish to proceed.
5) The page refreshes, removing the item from the Deleted items page.

The item is placed back into the log it was deleted from.

How to Undelete Multiple Items

For all project logs that have the option to delete multiple items, you can now undo multiple
deleted items. Select to undo all deleted items or selectively choose items. The events are
audited and can be viewed under Event History.

To undelete multiple items:

1) Select a project and go to the appropriate log.

2) Select Deleted Items from the Filter drop-down list at the top right corner. Only deleted
items appear in the log.

12

3) Select the item that needs to be undeleted and select Gear > Undelete Items. The

Undelete Items dialog box appears.
4) Enter a reason for undoing the selected deleted items.
5) Select Undelete. The item is placed back into the log it was deleted from.

Manage Drawings

Use the Manage Drawings page to manage, upload, replace, or delete multiple files at the
same time. This option is available only for Log Type 6 (Design Documents, Planroom, and
Drawings ).

1) Select a project and navigate to your log.

2) Select the Manage Drawings link from the top (Classic View) or from the Actions
drop-down menu (Standard View). The Manage Drawings page is displayed.

3) From the Manage Drawings page, select your categories and select Apply.
4) From the Manage Drawings, you can do the following:

a. To add a new file: Select the Add New button from the grid. A new line is displayed on
the grid. Enter a description and select a file by browsing. You can drag and drop files
from the right pane (Files pane) onto the main grid. To add or replace multiple files from
your library in Submittal Exchange, select the My Library link.
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b. To replace files: Drop and drag files onto the right pane (Files pane) or by selecting
Browse. The system auto maps the file based on the name and file extension. A green
check mark is displayed next to files that are auto mapped. You can also drag and drop
files from the Files pane onto the main grid. The new file is displayed under the New
Drawing column

c. To delete files: Select the red x next to files. Note you are deleting the file only from the
Manage Drawings page and not from the log.

d. To split a PDF file: Select the Split PDFs checkbox to create a drawing set by splitting a
multi-page PDF file into separate drawings. For each split file the remarks field is updated
with the page number in the format Page ‘n’ of ‘Master File.pdf. You can edit or delete the
page number.

e. To update multiple remarks: Select the Edit Remarks for All button. Enter your
comments and select Apply. This option will replace all existing comments.

Select Save.

Optional step. Provide feedback to the Oracle Submittal Exchange team on your experience

with the Split PDF feature. Enter your feedback and select Save. You can choose to enable
or disable the feedback notification from the My Account page.

Tip:

While adding PDF files, you can choose to flatten PDF files.

Moving a Submittal to Another Section

When logged into Submittal Exchange, select a project and go to the appropriate log.

1)
2)
3)
4)
5)
6)
7)

Select the submittal that must be moved. (Anything but the file.) A dialog box appears.
Select Edit Detail in the top right corner. The dialog box changes.

Select Move section in the top right corner. The dialog box changes.

Use the Move to log field to select the log to which the item should move.

Use the Move to Section field to select a section.

Select the section under which the item should move.

Select Save.

The submittal is now moved to the new section.

Note: If section sequential numbering is used, the submittal number will
adjust to reflect the new section number.

Removing a Category from a Log

1)

2)

When logged into Submittal Exchange, select a project and go to the log from which the
category should be removed.

Make sure there are no documents within the category for the specified log.
If there are documents:
a. Select the description of the item within that category. A dialog box appears.
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Select Edit Detail in the top right corner of the dialog box.
Select Move Item in the top right corner of the dialog box. A new dialog box appears.
Select the category where you plan to move the item.
Select Save.

f. Repeat steps a through e for all items within the category that need to be removed.
3) Gotothe Preferences tab.

» Select the log from which a category must be removed.

» Deselect the category that must be removed.
4) Select Save.

®cooo

Reordering Categories

When logged into Submittal Exchange, go to the Preferences tab.

1) Inthe Project Logs box, select the Log Name.

2) Inthe Log Box select the category that you wish to move, hold down your left mouse button,
and drag it to the desired location.

3) Select Save changes.

Note: This task can only be performed by the Project Leader. If you are
unable to reorder the categories, please contact your Project Leader.

Reordering Logs

When logged into Submittal Exchange, go to the Preferences tab. Towards the middle of the
page is a list of the current logs.

1) Click and drag logs to the desired location.
2) Select Save changes.

Restrict Log Access

When logged into Submittal Exchange, go to the Preferences tab.

1) Select the log needing restricted access. A dialog box appears.
2) Select Restrict Log Access.
3) Select Save at the bottom of the dialog box.
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Notes:
= Only team members with access to those Sections or Categories will
see the information within the log.

= There is no All Activity link in these logs. If a team member is listed
on only some of the sections or categories within the restricted log,
the team member will ONLY see the sections to which they are
assigned.

= [f the user is not listed on any section or category within that log, then
the log is not visible at all from the Project Logs tab.

= This task can only be performed by the Project Leader. If you are
unable to restrict log access, please contact your Project Leader.

Reorder Project Roles on the Project Team Page

As a Project Leader, you can reorder the Project Team page using project roles. You can use
the Manage Project Roles link to rearrange the roles displayed on the Project Team page. The
change is displayed at the project level for all team members.

To change the default order of the project roles displayed on the Project Team page:

1) When logged into Submittal Exchange, select a project and go to the Project Team tab.
2) At the top of the page, select Manage Roles.
The Manage Project Roles dialog box displays.
3) Select and drag the Reorder icon next to a role to change the order of display.
4) Select Close.

Uploading Photos to an Existing Gallery as a Project Leader or Gallery Owner

When logged into Submittal Exchange, select your project and go to the Photos log.

1) Locate the gallery you want to upload and select Add, or from the Gear menu, select Add
New Photo.

2) From the Add Photo dialog box. Either:
» Drag and drop photos from folders on your computer into the dialog.
» Select the Browse button and locate the file on your computer.

3) Optional. Enter a comment.

4) Optional. Use the rotate buttons to change the orientation of the image. Note, the original
orientation of the image is maintained when you upload.

5) Once you have chosen all photos, select Save.

101



Design Team User Guide

Tips:

= To delete a photo, select on the red x next to it. If you delete photos,
they are permanently removed from the project.

= You can select multiple photos to upload at the same time.

= You can upload, view, and edit your photos from a mobile device.

Editing a Photo Gallery

When logged into Submittal Exchange, select your project and go to the Photos log.

1) Locate the gallery you want to upload and select Edit, or from the Gear menu, select Edit
Gallery.

2) From the Edit Gallery page, you can change the name of the gallery, description, and
gallery owner. You can also add, edit, delete, and download photos.

3) Select Save.
Tip:

You can view and edit your photo gallery from a mobile device.

Downloading Photos

To download photos from your gallery to view or share with team members outside of Submittal
Exchange:

1) Select your project and go to the Photos log.

2) Select a photo gallery that includes the photos you want to download.

3) Click Download Photos.

4) Select individual photos or click Select all to select the photos you want to download.

5) Click Download to download selected photos individually, or click Download as Zip to
download a zip with all the selected photos.

Uploading Previous Files

When logged into Submittal Exchange you can do the following after selecting a project:

1) Select either the expected item for the item that requires an upload. A dialog box appears.
2) Select Edit Submittal Detail.
» You can change the number or the description if needed.
3) Starting from the top, select the plus symbol next to each role and fill out the information.
» Submittal from Subcontractor: Enter Date sent to architect.
» Submittal from GC: Enter Date received from GC and what was submitted.
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» Consultant Review: Enter Date Consultant reviewed. (if applicable)
» Architect Review:

Enter the Date returned to GC

Add the Action code

Select Hardcopy if you returned the submittal in hardcopy form or select Electronic to
upload your final electronic file.

» Return to Subcontractor: Enter Date returned to subcontractor.
4) Select Save.

Notes:

= These steps will ensure your submittal/RFI numbering lines up with
the current and future items. It is also helpful to have these
documents in one place to keep a record of them.

= The steps listed above may only be performed by a Project Leader on
the team.

Using the Event History as a Project Leader, Filtering by Event Type

When logged into Submittal Exchange, select a project and go to the Event History tab.

1) Select the event type for which you are searching from the Event Type drop-down list under
the Filter field.
Example: Expected Item Events

2) The system will search for all items that meet your criteria.

3) A list will show all events associated with that type of event.

Tip:
Events which require action to be taken via Email have the text Via Actionable Email next to
the event.

Using the Event History as a Project Leader, Filtering by User

When logged into Submittal Exchange, select a project and go to the Event History tab.

1) Select the user for which you are searching from the User drop-down list under the Filter
field.
Example: John Doe

2) The system will search for all items that meet your criteria.

3) A list will show all events associated with that person.

Tip:

Events which require action to be taken via Email have the text Via Actionable Email next to
the event.
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What are the Automatic Updates Options

When logged into Submittal Exchange, select your project and go to the Preference Tab.

1) Select Punchlist in the Project Logs field. A dialog box appears.
2) Under Update Emails, you can select either Automatic Updates or Manual Updates.
3) If selected, you can choose the frequency of Automatic Updates:

» Daily occurs every day at 6am CST.

»  Weekly occurs every Monday at 6am CST.

» Monthly occurs on the 1st of the month at 6am CST with the information pertaining to the
month prior.

4) Select Save.
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Adding Expected Items as an Architect

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Highlight the section that needs a new expected item. The Expected items in this section
field shows the current expected items.

2) Select Edit below the Expected items in this section field. A dialog box appears.

3) Either:
» Select standard expected items
» Enter custom text in the blank fields.

Note: Pre-numbering and required submittal dates can also be set here.

Performing Final Review as an Architect - No Additional Comments or Action

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require attention appear in red.

1) Select the description of the submittal you are reviewing. A dialog box appears. The default
option of Release without further comment is selected.
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2) Select Save and send. The Consultant's file is released as the final reviewed file.
Notification is sent to the General Contractor.

Performing Final Review as an Architect - Using PDF Editor

When logged into Submittal Exchange, select a project and go to the appropriate log. The items
that require attention appear in red.

1) Select the description of the submittal you are reviewing. A dialog box appears.

2) Select Add additional review.

3) Use the Action Code drop-down list to select the applicable code. If the item requires it,
select Requires resubmittal.

» Select the PDF editor with previous file icon. Within the first page select Continue. A
dialog box appears.

» Select Run in the dialog.

4) After Java is installed, the file opens. Use the editing tools at the top of the screen to add
comments and markup the document.

5) Select Save. The dialog box displays your file name.

6) Select Save and send. Your reviewed file uploads and an email naotification is sent to the
General Contractor.

Note: The speed of PDF editor is based on the size of your document,
the speed of your internet, and the speed of your computer.

Performing Final Review as an Architect- Adding an Additional Reviewed File

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require your attention will appear in red.

1) Select the file that was uploaded by the Consultant in the Submittal.

2) Use a PDF editing tool to open, review, add comments, and save the file to your computer.
3) Inthe Submittal log select the description of the item you reviewed. A dialog box appears.
4) Select Add additional review.

5) Select the applicable Action code using the drop-down list. If the item requires a
resubmittal, select Requires resubmittal.

6) Select Browse and upload your file. The name of your file appears under Browse.

Note: If your document is a PDF file and additional files need to be
associated with this review, you are able to upload multiple PDF
documents which will compress into one file.

7) Select Save and send. Your reviewed file uploads and an email notification is sent to the
General Contractor.
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Performing Final Review as an Architect - Using Form Editor and Adding an

Additional Reviewed File

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require your attention will appear in red.

1) Select the file that was uploaded by the Consultant in the Submittal.

2) Use a PDF editing tool to open, review, add comments, and save the file to your computer.
3) Inthe Submittal log select the description of the item you reviewed. A dialog box appears.
4) Select Add additional review.

5) Select the applicable Action code using the drop-down list. If the item requires a
resubmittal, select Requires resubmittal.

6) Select the form editor icon. The dialog box changes.
7) Complete information on the form.
8) Select Browse and upload your file. The name of your file appears under Browse.

9) Select Save and send. Your transmittal cover and reviewed file uploads and an email
notification is sent to the General Contractor.

Note: If your document is a PDF file and additional files need to be
associated with this review, you are able to upload multiple PDF
documents which will be combined into one file.

Performing Final Review as an Architect - Using Form Editor and Adding a

Consultant's File

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require attention appear in red.

1) Select the description of the submittal you are reviewing. A dialog box appears.

2) Select Add additional review.

3) Select the applicable Action Code using the drop-down list. If the item requires it, select
Requires resubmittal.

4) Select the form editor icon. The dialog box changes.

5) Complete the remaining fields. The Attach Previous File option is selected by default,
indicating the Consultant's file is attached to the transmittal cover.

6) Select Save and send. Your transmittal file attaches to the Consultant's file and uploads. An
email notification is sent to the General Contractor.

Performing Final Review as an Architect - Using a Form Editor and a PDF Editing

Tool

When logged into Submittal Exchange, select a project and go to the appropriate log. The items
that require attention appear in red.
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1) Select the description of the submittal you are reviewing. A dialog box appears.
2) Select Add additional review.

3) Select the applicable Action Code using the drop-down list. If the item requires it, select
Requires resubmittal.

4) Select the form editor icon. The dialog box changes.

5) Complete information on the form.

6) Select the PDF editor with previous file icon.
»  Within the first page select Continue. A dialog box appears.
» Select Run in the dialog box.

7) After Java is installed, the file opens. Use the editing tools at the top of the screen to add
comments and markup the document.

8) Select Save. The dialog box displays your filename.

9) Select Save and send. Your reviewed file uploads and an email notification is sent to the
General Contractor.

Changing an Expected Item from a Submittal to a Closeout or from a Closeout to a

Submittal

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the section that needs a submittal or closeout item adjusted. The section number and
name highlight in blue.

2) From under the Expected items in this section: box, select Edit.

3) Select either Submittal or Closeout from the drop-down list for the expected item.

4) Select Save.

Deleting Expected Items as an Architect

When logged into Submittal Exchange, select a project and go to the Sections & Categories
tab.

1) Select the section that needs submittal or closeout items removed.

2) From under the Expected items in this section: box, select Edit.

3) Deselect the expected items.

4) Select Save.

Note: Only General Contractors and Construction Manager project

leaders can use this method to remove expected items. Other users can
add items, but cannot remove them.
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Removing Someone from a Project as an Architect

Architects can remove users from their office as well as any consultants.
When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the check box next to the Team Members to remove.
2) From above the Architect Project Leader table, select Remove Selected Users.
» A dialog window appears. It lists the members to be deleted.

3) Select Delete. The Project Team screen refreshes and the team member no longer appears
in the table.

Note: If the user to be removed is no longer employed with the
company, contact Submittal Exchange Technical Support to have the
member's access to Submittal Exchange removed.

How to Renumber Submittals as an Architect

When logged into Submittal Exchange, select a project and go to the appropriate log.

1) Select the description for the submittal to renumber. A Submittal Detail dialog window
appears.

2) From the top of the dialog box, select Edit submittal detail.

3) Inthe Submittal number field, enter a new number.

4) Select Save.

5) The dialog window closes and the log displays the submittal with the new number.

Note: Subsequent submittals will continue following the numbering
pattern predetermined in the Preferences tab of the project.

Moving a Submittal to Another Section

When logged into Submittal Exchange, select a project and go to the appropriate log.
1) Select the submittal that needs to be moved. A dialog box appears.

Note: To select the Submittal choose the description, or anything in the
Section row of the table except the file itself.

2) Select Edit Detail in the top right corner. A dialog box appears.
3) Select Move section in the top right corner. A Move Section dialog appears.
4) Select the section to which you want to move the submittal.

5) Select Save and close to return to the log.
-Or-
Select Save and return to editing details to return to the previous dialog box.

The submittal is now moved to the new section.
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Note: This task can only be performed by the Project Leader and
Architect.

Releasing Physical Samples as an Architect

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require attention appear in red.
1) Select the description of the submittal item you are reviewing. A dialog box appears.
2) Within the Submittal from GC section:

» Enter the Date received from GC

» In the two drop-down fields next to Received from GC select the number of hard copies
in the first field and choose between Copies or Samples from the second.

3) Within the Architect Review section:
» Enter the Date returned to GC
» Enter the Action Code
» Add any comments in the Remarks from reviewer field

» Select Hardcopy under Returned to GC. Two drop-down fields appear next to the
Hardcopy field.
Select the number of hard copies in the first field and choose between Samples or
Hardcopy from the second.

4) Select Save.

Note: This system records that you received hard copies or samples
from the General Contractor and allows the Consultants to add their
reviews as needed.

What Email Notifications Are Sent to Architects?

Items Uploaded - Sent when General Contractors or Construction Managers upload Submittals
or Closeout item and when items are uploaded only to a Posting log

Reviews Completed - Sent when the Consultants review Submittal or Closeout documents.
Architects can take direct actions by using the action buttons provided in the email

Copy me on my Company Reviews - Sent when a company user uploads a reviewed item and
sends it back to the General Contractor or Construction Manager

Reminders - Sent based on the Required Item Turnaround date setting in the Preference tab;
these notifications inform users there are items awaiting review

Include Items Overdue from Contractor - Sent based on the Date Expected in the Full log;
this setting ensures email reminder notifications are received for items awaiting submission by
the Contractor or Subcontractors
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Changing Email Notifications as an Architect

When logged into Submittal Exchange, select a project and go to the Project Team tab.

1) Select the Team Member's email address. The Edit Team Member page appears.
2) Under the Member Email Settings section, choose the notifications the user should receive.
3) Select Save.

Note: If you cannot change email notifications, please contact you
Project Leader.
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Removing Someone from a Project as a Consultant

Consultants do not have the ability to remove users, including themselves, from the project
team.

If you or someone from your company needs to be removed from a project, please either contact
the Architect or Project Leader, who has the ability to remove any consultant, or contact
Submittal Exchange technical support at 1-800-714-0024 ext. 2 or email
subex-help_ww@oracle.com.

Reviewing and Releasing a Submittal as a Consultant

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require attention appear in red.

1) Select the file that was uploaded by the General Contractor or Construction Manager and
save it to your computer.

2) Open the file on your computer and place your review comments on the file using your PDF
editing tools.

3) When finished, save the file to your computer.

4) In the Submittal Exchange Submittal log, select the description of the item you reviewed
and are ready to release. A dialog box appears.

5) Select the applicable action code using the drop-down list. If the item requires it, select
Requires resubmittal.

6) Select Browse and upload your file. The name of your file appears under Browse.

Note: If your document is a PDF file and additional files need to be
associated with this review, you are able to upload up to multiple PDF
documents which will compress into one file

7) Select Save and send. Your reviewed file uploads and a notification is sent to the Final
Reviewer.
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Reviewing and Releasing a Submittal as a Consultant Using Form Editor

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require your attention will appear in red.

1) Select the file that was uploaded by the General Contractor or Construction Manager and
save it to your computer.

2) Open the file on your computer and place your review comments on the file using your PDF
editing tools.

3) When finished, save the file to your computer.

4) In the Submittal Exchange Submittal log, select the description of the item you reviewed
and are ready to release. A dialog box appears.

5) Select the applicable Action Code using the drop-down list. If the item requires it, select
Requires resubmittal.

6) Select the form editor icon. The dialog box changes.

7) Complete the information on the form.

8) Deselect the Use previous file option and select Browse.

9) Select Browse and upload your file. The file name displays in the dialog box.
Note: If your document is a PDF file and additional files must be
associated with this review, you can upload multiple PDF documents
which will compress into one file.

10) Select Save and send. The reviewed file uploads and an email notification is sent to the
Final Reviewer.

Reviewing and Releasing a Submittal as a Consultant Using Form Editor and

Submittal Exchange's PDF Editor Tool

When logged into Submittal Exchange, select a project and go to the appropriate log. The
submittal items that require your attention will appear in red.
1) Select the description of the submittal you are reviewing. A dialog box appears.

2) Select the applicable Action Code using the drop-down list. If the item requires it, select
Requires resubmittal.

3) Select the form editor icon. The dialog box changes.

4) Complete the information on the form.

5) Select the PDF editor with previous file icon.
» This will launch the PDF editing tool with Java. Within the first page select Continue.
» Select Run in the dialog box.

6) After Java is installed, the file will open. Use the editing tools at the top of your screen to add
comments and markup the document.

7) When finished, select Save in the upper left hand corner. The Submittal Exchange Form
Editor dialog box displays the file name.

8) Select Save and send. Your reviewed file uploads and an email notification is sent to the
Final Reviewer.
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Notes:
= If you do not have Java installed on your computer, you will be
prompted to install it the first time you use the tool.

= The speed of PDF editor is based on the size of your document, the
speed of your internet, and the speed of your computer.

Why Don't Consultants' Items Turn Black After ltems Have Been Reviewed?

When logged into Submittal Exchange as a Consultant, select your project and go to the
appropriate log. Submittal items will remain red even after you have reviewed them.

Reasons the item remain red:

1) It allows the Consultant to re-review a document if necessary prior to the final review.

2) It allows multiple consultant reviews of a file. One Consultant can review the file while
another Consultant can select the same red line item to add additional reviews if necessary.

Once the Architect completes the review and releases the item back to the Contractor, the item
turns black for the Consultant and Architect, indicating that the item has completed the review
process.

What Email Notifications Are Sent to Consultants?

Consultants and engineers can change their own email notifications and those of their own
company. Project Leaders can change email notifications for all project team members.

Iltems Uploaded - You receive a natification of uploads by your General Contractor/Construction
Manager for Submittals/ Closeouts. You receive email notices when something is uploaded to a
posting only log.

Reviews Completed - You receive a natification when your company posts reviews of
documents.

Reminders - This is based on the Required Item Turnaround date setting in the Preferences
tab. This ensures you are aware there are items awaiting your review.
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Removing Someone from a Project as an Owner

Owners do not have the ability to remove users, including themselves, from the project team.

If you or someone from your company needs to be removed from a project, please contact the
Project Leader, who has the ability to remove any user, or contact Submittal Exchange technical
support at 1-800-714-0024 ext. 2 or email subex-help_ww@oracle.com.

How to Upload to a Posting Log

When logged into Submittal Exchange, select your project and go to the appropriate log.

1) Select the green upload arrow to next to category to which you are uploading. A dialog box
appears.

2) Enter a description.

3) Select Browse and upload your file.

4) The name of your file appears under Browse.

5) Select Save.

Note: To upload to a posting log, users must have access to the
categories within the Project Team tab and have permission to post in
the log, which is a setting the Preferences tab.
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